Contents

About this manual  15

   Document revision history  15
   What to Read First  15
   Related Publications  16

   Accessing IBM FileNet Documentation  16

   Conventions Used in this Manual  17
   Keyboard & Mouse Instructions  17
   Page Headers  17
       UNIX and Windows Server Flags  17
   Cautions, Notes, & Tips  17

   IBM FileNet Education  18

   Feedback  18
   Documentation feedback  18
   Product consumability feedback  19

1  Overview  20

   COLD Features  21

   COLD Basic Concepts  22
   Background Templates  22
   Document Length Control  23
   Indexing  23
   Table of Contents  24
2 Preparing for an Import Job 30

How to Begin 31
Starting COLD on UNIX 33
Starting COLD on a Windows Server 34

The COLD Main Menu 35
COLD Application Commands at System Prompt 36

Define Background Template 36
About Templates 37
The Background Template Definition File 38
The Background Template Image 38
To use a 400 dpi background template: 39
Create a New Background Template 39
Select a Background Template 40
Delete a Background Template File 42
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Table of Contents</td>
<td>72</td>
</tr>
<tr>
<td>Table of contents identifier</td>
<td>73</td>
</tr>
<tr>
<td>Table of contents keys</td>
<td>74</td>
</tr>
<tr>
<td>Table of contents layout</td>
<td>75</td>
</tr>
<tr>
<td>To generate a table of contents</td>
<td>77</td>
</tr>
<tr>
<td>Enable Page Compression</td>
<td>79</td>
</tr>
<tr>
<td>To enable/disable page compression</td>
<td>79</td>
</tr>
<tr>
<td>Designate a Document Class</td>
<td>79</td>
</tr>
<tr>
<td>To specify a document class</td>
<td>80</td>
</tr>
<tr>
<td>Document Class Index Names</td>
<td>80</td>
</tr>
<tr>
<td>Specify Indexing Information</td>
<td>84</td>
</tr>
<tr>
<td>To specify indexing information—Source: Constant:</td>
<td>87</td>
</tr>
<tr>
<td>To specify indexing information—Source: Document:</td>
<td>90</td>
</tr>
<tr>
<td>To specify indexing information—Source: Run Date:</td>
<td>92</td>
</tr>
<tr>
<td>To specify indexing information—Source: No Value:</td>
<td>93</td>
</tr>
<tr>
<td>To specify indexing information—Source: 1st TOC Page &amp; Last TOC Page:</td>
<td>94</td>
</tr>
<tr>
<td>To specify indexing information—Source: Keyword:</td>
<td>95</td>
</tr>
<tr>
<td>Specify Index Identification Method</td>
<td>97</td>
</tr>
<tr>
<td>To obtain index values by length</td>
<td>98</td>
</tr>
<tr>
<td>To obtain index values by token concatenation:</td>
<td>99</td>
</tr>
<tr>
<td>To obtain index values by filter mask</td>
<td>100</td>
</tr>
<tr>
<td>Find Index Values Using Offset Coordinates</td>
<td>101</td>
</tr>
<tr>
<td>Specify Filtering, Multiple Templates, &amp; Tables of Contents</td>
<td>106</td>
</tr>
<tr>
<td>Page Filter</td>
<td>106</td>
</tr>
<tr>
<td>To extract indexing values from filtered pages:</td>
<td>108</td>
</tr>
<tr>
<td>To filter pages</td>
<td>109</td>
</tr>
<tr>
<td>To filter a single page</td>
<td>110</td>
</tr>
<tr>
<td>Line Filter</td>
<td>110</td>
</tr>
<tr>
<td>To filter a line by line number</td>
<td>111</td>
</tr>
</tbody>
</table>
Contents

To filter lines by search literal: 112
To use partial line filtering: 113

Select a Default Template 114
To select a default background template: 114

Add, Modify, or Delete Templates 115
To add a template to a Report Format: 116
To modify a template in a Report Format: 119
To delete a template from a Report Format: 120

The Page Setup Dialog Box 121
Font 123
Lines/Inch 124
Top/Left Margin in Inches 125
Characters/Inch 125
Style 126

Save the Report Format File 126
Delete the Report Format File 126

Define Import Job 127
Create the Import Job File 127
To specify a job name: 128
Job Description 129
Fixed-Length Line 129
Characters Per Line 129
Variable-Length Line 130
End-of-Line Characters 131
Specify a Channel Control File Name 131
Select a Report Format 131
Save the Import Job File 132
Delete the Import Job File 133
3 Running an Import Job 134

Preview Documents 134
Select a COLD Job to Preview 135
Preview & Search Data 137
   Preview Seek Methods & String Location 139
Online Template Alignment 141
   To adjust template alignment: 142

Import Documents 145
Start a New Import Job 145
   To start a new import job: 145
Restart an Import Job 148
   To restart a disk file import job: 149
   To restart a multi-tape import job: 150

View Import Log 150
   To view an import log: 150
The Import Log Fields 152
   Error Log 153

Automating COLD 154
Overview of 3770 Daemon Processing 155
File-Naming Conventions for Automatic Processing 156
The COLD 3770 Command & Options 157
   Syntax 158
   Define Directory Options (–d, –m, –s) 158
   Define Data File Directory (–d) 158
   Define Marker File Directory (–m) 159
   Save Data Files (–s) 160
   Define Translation Table (–t) 160
   To define a translation table for UNIX platforms: 161
Contents

COLD Formatting During Data Processing 173
Preprocessing 175
Postprocessing 175
Output Data Formats 176

Appendix B – Disk Space Management 177
Managing Disk Space 177

Appendix C – Performance Factors & Restrictions 179

Performance Factors 179
Input Source (Disk or Tape) 179
Space Required in Page Cache 179
System Activity 179
Type of Server 180
Document Length 180
Number of Index Values per Document 180
Source of Index Values (Constants or Variables) 180
Amount of Data per Page 180
Variable- vs. Fixed-Length Documents 181
Variable- vs. Fixed-Length Records 181
ASCII vs. non-ASCII Data 181
Table of Contents Processing 181
Filtering 181
Keyword Search 182

Restrictions & Considerations 182
Contents

Notices  201

Trademarks  204
U.S. Patents Disclosure  205

Index  206
About this manual

The COLD Handbook supports COLD for IBM® FileNet® Image Services and describes how to use the COLD software. (COLD is an acronym for Computer Output to Laser Disk.) We assume that you have a working knowledge of UNIX® or Windows® Server operating systems and workstations, and an understanding of the FileNet software methods of document entry, scanning, indexing, retrieving, and printing operations.

Document revision history

<table>
<thead>
<tr>
<th>FileNet Image Services version</th>
<th>Date</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.2</td>
<td>May 2011</td>
<td>Initial release.</td>
</tr>
</tbody>
</table>

What to read first

If you are not familiar with the FileNet COLD functionality, you should read Chapter 1, “Overview,” on page 20. This chapter describes the basics of COLD processing.

The “Glossary,” on page 197 explains terms used in this manual.
Related Publications

This manual includes specific information about using COLD, but does not detail the basics of operating the FileNet system. The manuals listed below provide more detailed information on other applications that can help you to use COLD more efficiently. For information on accessing these documents, see the next section.

- *FileNet Image Services System Administrator’s Handbook*
- *FileNet Image Services System Administrator's Companion for UNIX*
- *FileNet Image Services System Administrator’s Companion for Windows Server*

Accessing IBM FileNet documentation

To access documentation for IBM FileNet products:

2. Select the appropriate IBM FileNet product from the “Select a category” list.
3. On the Product Support page, click **Documentation** and then click **Product Documentation**.
4. On the Product Documentation page, locate the document you need, then click the icon in the appropriate release column to access the document.
Conventions used in this manual

The following paragraphs explain some of the conventions that we used in this manual.

Keyboard and mouse instructions

Assume that when we tell you to click on a button or object, we are referring to the left mouse button, unless we instruct you otherwise.

We indicate commands, values, and so on that you are to enter from your keyboard by using the following typeface:

Type this.

Page headers

Except for the first page of a chapter, you can tell where you are in the manual by looking at the top right-hand corner of a page. There, you can find the chapter name (on top) and the current main heading.

UNIX and Windows server flags

These flags have been added to appropriate sections of this manual to help you find required information more quickly.

Important, attention, & tips

To call attention to important information, you will see the following message types:
Important  Signals possible unexpected consequences of an action, such as loss of data or time.

Attention  Draws your attention to essential information that you should be sure to read.

Tip  Introduces an idea that might make your work easier.

IBM FileNet education

IBM FileNet provides various forms of education. Please visit Global Learning Services on IBM’s Web site at (www-306.ibm.com/software/sw-training/).

Feedback

We value your opinion, experience, and use of our products. Please help us improve our products by providing feedback or by completing a consumability survey.

Documentation feedback

Send comments on this publication or other IBM FileNet Image Services documentation by e-mail to comments@us.ibm.com. Be sure to include the name of the product, the version number of the product, and the name and part number of the book (if applicable). If you are commenting on specific text, include the location of the text (for example, a help topic title, a chapter and section title, a table number, or a page number).
Product consumability feedback

Help us identify product enhancements by taking a Consumability Survey ([http://www-306.ibm.com/software/data/info/consumability-survey/](http://www-306.ibm.com/software/data/info/consumability-survey/)). The results of this comprehensive survey are used by product development teams when planning future releases. Although we are especially interested in survey responses regarding the most recent product releases, we welcome your feedback on any of our products.

The survey will take approximately 30 minutes to complete and must be completed in a single session; there is no option to save a partially completed response.
Overview

Typically, you enter documents into the FileNet system by scanning them and then entering the index values associated with each document to facilitate later retrieval. This is usually done using a document entry program. The FileNet system stores the scanned images on optical disk and adds the index values into a relational database. You can then use the index values to retrieve and display the images.

However, when the data is ASCII or EBCDIC text on magnetic tape or disk, you can import it directly into the FileNet system without scanning or manual indexing. To do this, you read the data using the FileNet COLD (Computer Output to Laser Disk) program. COLD is a document entry alternative to scanning.
Overview

COLD features

When the COLD data has been indexed and stored on optical disk, you can retrieve, display, and print COLD documents just like any other scanned document. As a printing and display option, you can superimpose COLD data on a scanned background image. For example, you could use a scanned invoice form as a background image (template) and superimpose the COLD data on the background image to create an invoice.

With COLD you can view text data as document images at a workstation rather than referring to paper print-outs or microfiche, thus reducing your need for traditional storage space for paper or film. Also, you can retrieve COLD documents more quickly and easily than you can paper documents.

Some other features of COLD are:

- COLD is totally integrated with the FileNet imaging and workflow management software.

- COLD permits the use of background templates in formatting the text data. With this feature, you can print or display your data on the equivalent of a preprinted form.

- COLD automatically creates a maximum of three different tables of contents for each document, which you can use for reference such as a list of telephone numbers.

- Because text files are small compared to images, COLD data requires relatively little space on optical disk.
COLD basic concepts

The following pages briefly describe some of the basic concepts that you need to know to work with the COLD software.

Background templates

A background template is a committed FileNet image that supplies fixed text and graphics to enhance the data. COLD superimposes the data that it processes onto the background template image.

You can specify one template for the table of contents and other templates for different pages of data.
Document Length control

A COLD document can have as many as 1,000 pages. If COLD does not encounter an end-of-document indicator after 1,000 pages, it automatically creates a new document. With COLD, you can designate either fixed- or variable-length documents. A document can have a maximum of three tables of contents. (Sorting the data for multiple tables of contents using different data on each one can save time searching for records.) For information on tables of contents, see “Table of contents” on page 24.

Indexing

You can specify index information as a constant or a variable. A constant index value does not change from document to document, such as the run date. You supply the constant index values.

A variable index value does change from document to document, such as an invoice total. For COLD to extract a variable, you must supply its exact location in the data. If the data occurs in a different location on every page, you must supply an identifying keyword and the associated coordinates for each occurrence. COLD searches for the keyword literal and the coordinates to extract the variable indexing value.

To see if the correct indexing values are present, you can run the Preview Documents program. (For more details on indexing, see “Specify indexing information” on page 84. For more details on previewing documents, see “Preview documents” on page 134.)
Table of contents

You can use a table of contents for locating data in the document or as a handy reference, such as a list of customer names. COLD can generate a maximum of three tables of contents for each document by looking for a sequence of characters, such as a name, in the same place on each page. Each time the sequence of characters changes, COLD adds the new characters and corresponding document page number to the table of contents.

If you specify multiple tables of contents, you might use one for a list of customer names, another for zip codes, and a third for products purchased. For information on tables of contents, see “Specify filtering, multiple templates, and tables of contents” on page 106.

Formatting COLD data

You can format your COLD data for printing and displaying by selecting fonts and by setting lines-per-inch and margins.

You can also use COLD’s channel control character feature to control formatting. Your installation might already be using channel control characters (sometimes called printer control characters) in the data that you import to COLD. The channel control character resides in the first column of a line, and can specify paging, line spacing, vertical positioning of text on a page, and line filtering. Use the Define Channel Control File application to indicate to COLD what channel control characters are in your data and assign data formatting to those characters.
Unattended operation

You can set COLD to do most of its data processing at night or at another time when system activity is low. You can use the 3770 daemon program for this purpose.

The daemon program runs in the background and opens and searches a specified directory for files containing COLD data. The default directory the daemon searches is /fnsw/local/tmp/3770, and the default search (polling) frequency is once every 60 seconds.

Upon encountering a COLD data file, the daemon program starts the import process. Files processed by COLD in this way could have been transferred to a FileNet Image Services server from a mainframe by way of RJE/SNA services, ftp, rcp, or other methods.

For more information about the COLD 3770 daemon and unattended operation see “Automating COLD” on page 154.

Document class security

A COLD document acquires the security of its document class. After committal, you can change the security of a COLD document by using the Maintenance option in the Query Match Report, as with any other document. See the Desktop documentation or help system for details.
Preview documents

You can preview pages before beginning an actual COLD import job to ensure that the import process runs correctly. Select COLD's Preview Documents function from the COLD Main Menu to display the preview windows.
Multi-byte character support

You can import multi-byte data, use multi-byte characters in certain indexes, and use COLD Preview to align multi-byte data.

About “Characters”

In this manual, the term “character” usually means the single-byte English language letter, symbol, or digit. However, in this release of the FileNet Image Services software, COLD also provides partial support of multi-byte (16-bit NLS) characters for use with the Japanese language.

Japanese data

Although this version of COLD and FileNet Image Services supports the use of multi-byte Japanese data, any search string, literal, document class, index value, report ID name, etc., must be in English.

Requirements for COLD multi-byte character support

UNIX platforms

In order to commit or import COLD multi-byte documents to UNIX platforms, the Japanese locale must be installed and the LC_CTYPE environment variable must be set to point to the Japanese locale.

For instructions, contact your platform hardware vendor.

Windows Server platforms

The Japanese Windows Server Operating System must be installed.
Overview

Multi-byte character support

Limitations

The following list describes what you can, and cannot, do in COLD with multi-byte data.

- Multi-byte characters are supported only on Combined servers; AIX®, HP-UX, Solaris, and Windows Server.
- COLD Preview of Japanese data is only supported on Windows Servers that have the Japanese Windows Server Operating System installed.
- All keyboard input to COLD must be single-byte.
- All jobs must be fixed length.
- All jobs must be variable pages.
- All COLD jobs support a maximum of 255 bytes per line.
- The Document source index type supports multi-byte data.
- For multi-byte data, only the ‘length’ index identification method is supported. The Token Concatenation and Filter Mask identification methods are not supported.
- If the index value is a constant, the literal must be a single-byte character string.
- If the ‘Keyword’ feature is used, the keyword must be a single-byte character string.

Not supported

The following is a list of items that are not supported in COLD with multi-byte characters.
Overview

Multi-byte character support

- Multi-byte characters are not supported in the Table of Contents.
- Page Compression is not supported for multi-byte data.
- No multi-byte translation, for example EBCDIC to ASCII, is supported.
Preparing for an import job

This chapter specifies what information you need to supply to COLD's various job files before beginning an import job.

The following flow chart explains the various requirements for running an import job.

The arrows in this illustration indicate the relationships between the various files required to process an import job. For example: document classes must be defined before defining a report format, and the report formats must be completed before defining the import job.

The file name examples used in this manual are noted in the appropriate process.
How to begin

Before you can create the job files for a COLD session, you must have a number of facts on hand. If you copy and then fill in the prepared checklist on page 189, you can save it for a record of each import job’s attributes in case you need to re-create job files. The following list gives you an idea of the information that you need:

Tip You can also save printouts of the job files.

- The password to the console and password to the FileNet system.
- The background template file name, or the document ID of the image if you are defining a new background template.
- The channel control file name.
- The channel control characters that are used on the data at your installation.
- The number of pages per document, the number of columns per page, the number of lines per page, and the number of characters per line.
- The line and column numbers of the data that COLD will use as a report identifier, table of contents key, and indexing information.
- The document class name that you will associate with your COLD output.
Preparing for an import job

How to begin

At least one FileNet document class must be available for COLD committals. The document class defines the index values that you can use later to retrieve the documents that you commit to optical storage. Although you can specify where COLD finds the index, or its value if it is a constant, you cannot change the index itself. For example, you can specify that an index named Invoice# appears in line one, column 60, but you cannot change Invoice# to Employee#. If you need an index named Employee#, you must add it to the document class.

You create or modify the document class and indexes in the FileNet Image Services Database Maintenance program. In this handbook, we assume that the appropriate document class—complete with index definitions—already exists and that you know the document class name.

If you do not know the name of the document class to use for your COLD documents, please see your system administrator. If you want to create or modify a document class (for example, to add or change an index), refer to the FileNet Image Services System Administrator’s Handbook for your system. To download IBM FileNet documentation from the IBM support page, see “Accessing IBM FileNet documentation” on page 16.

- The input data format—whether it is ASCII, EBCDIC, or some other character set.
- The full path name of the file that contains the COLD data to process.
- The input data source—whether it comes from tape or disk.
Preparing for an import job
How to begin

☐ If you plan to use the variable-length record feature, you need to know the type of end-of-line characters (carriage return, line feed, etc.) used in your data.

Starting COLD on UNIX

To use the COLD software on UNIX-based platforms, you need to log on to the FileNet system as described below.

Attention

Commands on UNIX-based systems are case-sensitive, whereas commands on Windows Server systems are not.

1 At the FileNet server logon prompt, enter the command below, and then press the Enter key.

   fnsw

   The system displays the fnsw password prompt.

2 At the fnsw password prompt, enter your password, and then press the Enter key.

   The system displays the system prompt.

3 At the system prompt, enter the command below, and then press the Enter key.

   Xapex

   The system displays the User Name and password dialog box.
Preparing for an import job

How to begin

4 In the User Name field, enter your user name, and then press the Tab key to move to the Password field.

5 Enter your password, and then press the Enter key, or click OK. The FileNet Application Executive window displays.

6 From the FileNet Application Executive window, select COLD. This displays the COLD Main Menu.

Starting COLD on a Windows Server

On a Windows Server system, follow the procedure below to log on to the FileNet system.

1 From the Start menu, select Programs/FileNet Image Services/Server Applications. This opens the Server Applications dialog box and the Logon dialog box.

2 In the Logon dialog box's User Name field, enter your user name and then press the Tab key to move to the Password field.

3 Enter your password and press the Enter key. You can also click on the OK button. This opens the Applications Executive dialog box.

4 Select the Applications menu to display a list of FileNet applications.

5 Select COLD to display the COLD Main Menu.

Tip Instead of going through these steps, you can create an Apex icon on your desktop to make logon easier. See your system manual for more information.
Preparing for an import job

The COLD Main Menu

The remainder of this chapter discusses the first four Main Menu items in the order that they appear on the menu. You'll use the first four Main Menu items to create the job files that are required for running an import job. The organization of the Main Menu is a good guideline for the order in which you complete the requirements for running an import job. The last three Main Menu items describe the various aspects of running an import job and are discussed in the next chapter, "Running an import job" on page 134. Each menu item, except Preview Documents, can create an ASCII file, which you can edit and print.

An illustration of the COLD Main Menu is shown below.
Preparing for an import job
Define background template

COLD application commands at system prompt

The commands below mirror the functions on the COLD Main Menu. At times you might find it convenient to run the COLD applications from the system prompt. The commands are the same on all platforms. You can usually find these commands in the directory /fnsw/bin.

<table>
<thead>
<tr>
<th>Description</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>COLD Main Menu</td>
<td>Xcold_menu</td>
</tr>
<tr>
<td>Define Background Template</td>
<td>Xcold_tem</td>
</tr>
<tr>
<td>Define Channel Control File</td>
<td>Xcold_ch</td>
</tr>
<tr>
<td>Define Report Format</td>
<td>Xcold_rpt</td>
</tr>
<tr>
<td>Define Import Job</td>
<td>Xcold_job</td>
</tr>
<tr>
<td>Preview Documents</td>
<td>Xcold_ver</td>
</tr>
<tr>
<td>Import Documents</td>
<td>Xcold_imp</td>
</tr>
<tr>
<td>View Import Log</td>
<td>Xcold_log</td>
</tr>
</tbody>
</table>

Define background template

You can enhance data output and display by specifying that COLD use a background template. The background template displays with the data and can contain text and graphics (such as your logo). Using a background template is optional; you can print, process, and view COLD data without a background template. If you do not plan to use a background template, you can skip to “Define channel control file” on page 42. This section explains how to create templates, and how to use them with your data.
About templates

The background template is a committed FileNet image that provides constant text or graphics upon which COLD superimposes the data for displaying or printing. A template can act as a preprinted form, such as an invoice or purchase order.

Like all FileNet images, the background template belongs to a document class. However, because you use it strictly as a background form for COLD data, the template does not use indexing. Therefore, you would not normally assign index values to the document class used for your COLD background templates.
Preparing for an import job

Define background template

The background template definition file

When you use the Define Background Template function from the COLD Main Menu to select a background template, COLD creates a background template definition file on your FileNet Image Services server (a text file). This definition file resides in the /fnsw/local/cold/templates directory. The file contains the document ID of the committed image that you select as a template. Later, when defining your Report Format, you supply this file name. If you do not have this information, please see your system administrator.

COLD refers to this definition file while processing your data, reads the document ID, then retrieves the image file from optical storage or cache. COLD then uses this image as a background template for your COLD data exactly as you specify when you define the Report Format for your data. You can see a list of all background template definition files in the Define Background Template window. See “Select a background template” on page 40 for more information about displaying the list of templates.

The background template image

You do not create templates in the COLD application. The template must be a previously-stored (committed) image. The background templates must be TIFF images in resolutions of 100, 200, and 400 dots per inch (dpi). For best results when printing, use templates scanned in at 200 or 400 dpi. The following procedures explain what you must do to use 400 dpi templates.
Preparing for an import job
Define background template

To use a 400 dpi background template:

If you are using a 400 dpi background template, you must perform the
following steps for your output to print correctly:

1. In /fnsw/local/cold/config (for UNIX), or, \fnsw_loc\cold\config (for Win-
dows Server), create a text file named:

   COLDresolution.txt

   **Attention** This file must have a .txt extension for COLD to recognize the file and
   be viewed properly in the COLD Preview display screen.

2. Open the file and enter the resolution value:

   400

Create a new background template

Before defining a template, you might want to print the COLD input
data file from your mainframe or tape to a standard line printer, and
then create a layout grid to locate the data (lines and columns). This
procedure can help you match the background data to your template
and also help you identify which line and column numbers you want
COLD to use when extracting values and formatting pages.

You can also use the information in “Preview seek methods and
string location” on page 139 to locate the first occurrence of specific
data on a page. This method is only of value when the field uses for-
matted data. Some fields require preformatted data for the search to
work.
Select a background template

The following paragraphs explain how to select a background template to use with your data.

1 On the COLD Main Menu, click the Define Background Template button to display the Define Background Template dialog box.

2 Click the List button next to the Template Name field. COLD displays the Selection Box containing a list of all background template files available on this system.

3 Select a background template from the list.

If you are naming a new template, enter a name in the Selection field. Use standard file-naming conventions. The name can’t be all numeric, and the only special character that you can use is the underscore (_). The maximum length of the Selection field is 14 characters.
4 Click the OK button. COLD returns you to the Define Background Template window.

- If you are defining a new template, continue to the end of these procedures to enter its description and document ID.

- If you have selected an existing template, you can close the Define Background Template window and return to the COLD Main Menu where you can continue defining the parameters for your data.

5 In the Description field, enter a description of the background template. This makes it easier to select the correct template. The maximum length of the Description field is 30 characters.

6 In the Document Number of Template field, enter the document ID number of the committed image that you want to use as a background template.

7 From the Define Background Template window’s File menu, select Save.

COLD verifies that the image’s document ID is valid and that the image document is type IMAGE.
Delete a background template file

The following steps explain how to remove a background template from COLD's list of available templates.

1. On the COLD Main Menu, click the Define Background Template button to display the Define Background Template window.

2. Click the List button next to the Template Name field. COLD displays the Selection Box containing a list of all template files available on this system.

3. Select the desired background template from the list.

4. From the File menu, select Delete.

Define channel control file

This section defines some of the data formatting that you can specify using a channel control file. Later sections in this manual explain more formatting that you can do using other tools. You should be aware of how these other tools and channel control character formatting can affect your final data output. Please see “COLD formatting during data processing” on page 173.

Before you begin the procedures in this section, collect the data listed in “How to begin” on page 31.
About channel control characters

The raw data that COLD processes contains special characters in the first column on each line of data. These characters are intended as formatting flags for data output and are called channel control (or printer control) characters.

Attention

The COLD software always assumes that the first character on each line of data is a channel control character.

The channel control character indicates what kind of formatting is done to that line when it is displayed or printed. For example, a blank in the first column might cause a line to be single-spaced. A zero in the first column might cause another line to be double-spaced. A hyphen might cause a line to be triple-spaced. You can define other characters to cause page breaks, vertical spacing, and line deletions.
About channel control files

To use channel control characters to format your data, you must specify a channel control file that contains a list of the characters in the first column of your data and describes the type of formatting they do. You must know the name of this channel control file and the channel control characters and their definitions. If you do not have this information, please see your system administrator.

You can use either the default channel control file provided with the COLD software (FN_DEFAULT), or you can create your own channel control file that includes the channel control characters contained in your data. Channel control files are stored in /fnsw/local/cold/channel on UNIX-based systems, and in \fnsw_loc\cold\channel on Windows Server systems.

COLD provides for a maximum of 255 channel control characters per channel control file.
Format data using channel control characters

The following table explains the format attributes that you can apply to data by using channel control characters.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Spacing</td>
<td>You can specify the placement of a line of data on the page relative to the previous data. This involves inserting blank lines before the specified line of output.</td>
</tr>
<tr>
<td>Vertical Tabs</td>
<td>This tab places the output on a specified line on the page. The field accepts values through 999. Do not enter more than the actual number of lines per page.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can define a channel control character with either spacing or vertical tabbing instructions, but not both.</td>
</tr>
<tr>
<td>Pagination</td>
<td>This character specifies the beginning of a new page. If you use the default channel control file, the program begins a new page when encountering a “1” (one) in the first column. Any values in the Spacing or Vertical Tab fields apply to the new page.</td>
</tr>
<tr>
<td>Ignore Lines</td>
<td>The default channel control file lists both “&amp;” and “+” as ignore-line characters. When the program encounters the ignore-line character, the entire line is skipped and does not increment the line count.</td>
</tr>
<tr>
<td></td>
<td>If you use a channel control character to ignore a line, COLD cannot extract index information or other data from it. To omit lines from committal but still extract index information or other data, see “Page filter” on page 106. For more information on the difference between these two ways of removing data, see “COLD formatting during data processing” on page 173.</td>
</tr>
</tbody>
</table>
Preparing for an import job
Define channel control file

The default channel control file

The default channel control file, FN_DEFAULT, contains standard channel control characters that might be in use at your installation. The FN_DEFAULT file contains the following character definitions:

<table>
<thead>
<tr>
<th>Character</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>blank</td>
<td>Single-spaced line.</td>
</tr>
<tr>
<td>0</td>
<td>Double-spaced line. (Counts as two lines: the text line plus one blank line.)</td>
</tr>
<tr>
<td>–</td>
<td>Triple-spaced line. (Counts as three lines: the text line plus two blank lines.)</td>
</tr>
<tr>
<td>1</td>
<td>First character of a new page. This character starts a new page even if the character occurs before the expected end of a page.</td>
</tr>
<tr>
<td>&amp;</td>
<td>Ignored line. (Line counter not incremented.)</td>
</tr>
<tr>
<td>+</td>
<td>Ignored line. (Line counter not incremented.)</td>
</tr>
</tbody>
</table>

You cannot edit the default channel control file. You can, however, save and rename the default channel control file, and then edit the resulting file.

The following illustration shows how raw data might display and print using the default channel control file.
If you are converting from COLD 1, you must use the FN_DEFAULT Channel Control file. The channel control characters that it contains are the only ones that were supported in COLD 1.
Create a custom channel control file

If the existing channel control files are not suitable for the data, you can create your own channel control file based on the FN_DEFAULT file or another channel control file. The following procedures explain how:

1. From the COLD Main Menu, select Define Channel Control File. This displays the Define Channel Control File window.

2. To display a list of available channel control files, click on the List button. COLD displays a list of channel control files available on your system.

3. Depending on the channel control characters in your data, select a channel control file that suits your needs.

4. From the File menu, select the Save As option. COLD displays the Save As dialog box.

5. Enter the name of your choice. Use standard file-naming conventions. The maximum field length is 14 characters.

6. Click OK to save the name. COLD displays a dialog box with a message informing you that the file “was successfully saved.”
7 Click OK.

To make additions or changes to the new file, including adding a description, follow the steps in the “Edit a channel control file” on page 49.

Edit a channel control file

A channel control file lists the channel control characters and specifies the formatting that those characters indicate. When changing a file, you might need to add, modify, or delete channel control characters. You cannot modify the default channel control file, FN_DEFAULT.

Tip When running Windows 95, some channel control characters are hidden from Microsoft® Notepad and other editors. If you want to see those hidden characters, try opening the channel control file in Binary mode using the MS-DOS Editor. To start the editor, enter EDIT at the Run Command Line.

To edit an existing channel control file:

1 From COLD’s Main Menu, click on the Define Channel Control File button to display the Define Channel Control File window.
2 Click the List button to display the Selection Box.

3 Select the name of the desired file or enter the name of the file.

4 To add characters to the channel control file, click on the Add button and go to page 51.

To change characters in the channel control file, click on the Modify button and go to page 53.
Preparing for an import job  
Define channel control file

To delete characters from the channel control file, click on the Delete button and go to page 54.

**To add a character to the channel control file:**

1. In the Define Channel Control File window, click the Add button to display the Add/Modify Channel Control window.

2. Click the down arrow to the right of the Channel Control field to display a drop-down menu containing up to 255 channel control characters.

   The four positions on the left side of the list show the hexadecimal value of each character. The remaining text to the right describes each character.
Preparing for an import job
Define channel control file

3 Scroll down the list until you find the hexadecimal value and description that you want to use; then click on it to select it.

4 Enter values in the four remaining fields to specify the type of formatting you want COLD to apply every time it encounters the selected character in the first position of a line. The following table explains what happens when you enter information in one of these fields.

**Attention** Spacing and vertical tabbing are mutually exclusive formatting options. You cannot specify both for the same character.

<table>
<thead>
<tr>
<th>Field</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel control</td>
<td>This field displays the hexadecimal value and description for the selected channel control character.</td>
</tr>
</tbody>
</table>
| Spacing      | Enter a value for the desired line spacing that the selected channel control character is to implement:  
                           1 for single spacing  
                           2 for double spacing, etc.  
                           The Spacing field accepts as many as 999 blank lines. |
| Vertical tab | Enter the line number on which COLD is to place the data when encountering the selected channel control character. The field accepts values through 999. Do not enter a value greater than the actual number of lines per page. |
| Paging       | Enter the channel control character that signals COLD to begin a new page. The character that you enter must match the hexadecimal value and description. |
| Ignore       | Enter the channel control character that signals COLD to ignore a line. The character that you enter must match the hexadecimal value and description. |
Preparing for an import job
Define channel control file

5 After you specify the formatting for the selected character, click the OK button. This saves the changes to the file.

When you finish adding channel control characters, click the Cancel button to return to the Define Channel Control File window. Your defined character and its hexadecimal value display in the Character column.

6 In the Define Channel Control File window, you can choose to either:

- Continue to edit channel control characters in the selected file, or
- Return to the COLD Main Menu by selecting Save and then selecting Exit from the File menu.

To modify a channel control character:

1 In the Define Channel Control File window, select the channel control character that you want to change.

2 Click the Modify button to display the Add/Modify Channel Control window.

3 Change any values in this window as described in “To add a character to the channel control file:” on page 51.

4 Click the OK button. COLD returns you to the Define Channel Control File window and displays your changes.

5 In the Define Channel Control File window, you can choose to either:

- Continue to edit channel control characters in the selected file, or
- Return to the COLD Main Menu by selecting Save and then selecting Exit from the File menu.
To delete a character from the channel control file:

1. In the Define Channel Control File window, select the channel control character that you want to delete.

2. Click the Delete button. COLD displays a window that asks for confirmation. For example:

   Channel control character ‘[+]’ will be removed. Are you sure?

3. To confirm your deletion, click the Yes button. COLD returns you to the Define Channel Control File window. Your deletion is in effect.

4. You can choose to either:
   - Continue to edit channel control characters in the selected file, or
   - Return to the COLD Main Menu by selecting Save and then selecting Exit from the File menu.
Define report format

In addition to the Channel Control files, COLD gets further formatting instructions for the raw data by accessing one or more Report Format files. The Report Format includes rules for indexing, displaying, formatting, and printing documents. You can specify up to 200 Report Formats for any import job file.

Before you begin

Before you begin the procedures in this section, collect the data listed in “How to begin” on page 31. You might also want to read the section, “COLD formatting during data processing” on page 173.

Tip

Before defining the Report Format, you might want to print a few pages of the data from your mainframe; then create a grid to find the location of the various data that you plan to use (lines and columns). This is useful when filling in the Report Format fields. In the following example, a grid overlaying the data represents columns and lines.
You can also use the information in “Preview seek methods and string location” on page 139 to locate specific data.

The following sections describe how to complete the Report Format. These sections usually begin with a brief introduction and an illustration showing the items on the screen pertinent to the procedures.
Creating a Report Format is a relatively long procedure. Broadly, the steps are:

- Specify a name for the Report Format file.
- Define a value found in the data that uniquely identifies the Report Format file to use on that page.
- Define the various attributes to apply to the document, such as fixed- or variable-length document, how many lines per page, etc.
- Define how the document is to be committed: table of contents, page compression, document class, etc.
- Identify the source of the indexing information.
- Specify how many tables of contents to create, whether to use multiple background templates, and to filter pages or lines.
- Specify fonts and margins.
The Define Report Format window

From the COLD Main Menu, select Define Report Format to display the Define Report Format window where you specify the Report Format parameters.
Preparing for an import job

Define report format

Specify the Report Format name

The Report Format Name field identifies the name of the file that contains formatting instructions for the COLD data. You can either select an already-existing Report Format or you can enter a new name and begin defining its attributes. The Report Format files are stored in the directory /fnsw/local/cold/formats.

<table>
<thead>
<tr>
<th>Field or Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report format name</td>
<td>This is the name of the file that contains your formatting instructions.</td>
</tr>
<tr>
<td>List button</td>
<td>Click this button to display a list of the existing Report Format names. New names are added or changed here.</td>
</tr>
<tr>
<td>Description</td>
<td>This is the Report Format description. You can enter any description that is meaningful to you.</td>
</tr>
</tbody>
</table>

The items involved in this process are:
To define a Report Format name:

1 To display the Selection Box containing a list of current COLD report files, click the List button.

2 Select an existing Report Format file name. To create a new Report Format, enter a new Report Format file name (use standard file naming conventions). The maximum Report format name field length is 14 characters.

3 Click the OK button.

COLD returns you to the Define Report Format window.

4 In the Description field, enter any meaningful text describing the Report Format. The maximum Description field length is 30 characters.

Define the Report ID value

The Report ID is a constant value that COLD finds on the first page of your document to determine which Report Format applies to that document. You define the line, column, and character string that COLD must find. The Report ID (character string) literal must be on the first page of each document. You can define an appropriate report ID literal; or you can use the paging channel control character as a report ID. See “Format data using channel control characters” on page 45 for more information about channel control characters.

| Report ID | Line: 1 | Column: 2 | Literal: Acct | Length: 4 |
Preparing for an import job
Define report format

The items involved in this process are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>The line number on which COLD finds the Report ID literal.</td>
</tr>
<tr>
<td>Column</td>
<td>The column number in which COLD finds the Report ID literal.</td>
</tr>
<tr>
<td>Literal</td>
<td>The constant value (the Report ID literal) that COLD finds on the first page of your document to determine which Report Format applies to that document. If you use the paging channel control character as the Report ID literal, COLD locates the channel control character on the first page as follows:</td>
</tr>
<tr>
<td></td>
<td><strong>Variable-Length Documents</strong></td>
</tr>
<tr>
<td></td>
<td>Finds the start-of-document indicator(s).</td>
</tr>
<tr>
<td></td>
<td><strong>Fixed-Length Documents</strong></td>
</tr>
<tr>
<td>Length</td>
<td>The length of the literal. COLD automatically determines the length when you enter the characters in the Literal field.</td>
</tr>
</tbody>
</table>

For more details on defining Report ID values, see “Define Document Attributes” on page 62.

**Attention**

COLD looks for the report ID in the unformatted (preprocessed) data. This means that no channel control processing has been done. You should be aware of how channel control character formatting can affect your final data output. Please see “COLD formatting during data processing” on page 173.
Preparing for an import job
Define report format

To specify the report ID literal:

1. In the Line field, enter the line number where COLD can find the report ID literal.

2. In the Column field, enter the column number where the report ID literal begins.

3. In the Literal field, enter the report ID value (from your session checklist). The maximum length for the Literal field is 30 characters. COLD automatically determines the length when you enter the characters in the Literal field.

Define Document Attributes

Use the Document Attributes section to indicate whether the document's page count is fixed-length or a variable-length. Also, here is where you define the dimensions of the page.

- **Fixed page**
- **Variable page**

<table>
<thead>
<tr>
<th>Start of Document #1</th>
<th>Start of Document #2</th>
<th>Start of Document #3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line: 1</td>
<td>Line: 9</td>
<td>Line: 27</td>
</tr>
<tr>
<td>Column: 11</td>
<td>Column: 6</td>
<td>Column: 15</td>
</tr>
<tr>
<td>Length: 4</td>
<td>Length: 7</td>
<td>Length: 11</td>
</tr>
<tr>
<td>Boolean: And</td>
<td>Boolean: Or</td>
<td>Boolean:</td>
</tr>
</tbody>
</table>

Lines per page: 64
Starting output column: 2
Print text width: 50
Fixed-Length documents

If you select the Fixed Page button to indicate that the number of pages is to be fixed, each document will have the same maximum number of pages. A fixed-length document can have from one to a maximum of 1,000 pages. Fixed-length documents can have from one to three tables of contents. So, a document with seven images and three tables of contents would contain ten pages.

Tip
To save time, we suggest that you process similar pages (such as invoices) as one long document rather than a series of one-page documents. A 100-page document processes about four times faster than 100 one-page documents.

To define a fixed-length document:

1. In the Document Attributes section, click the Fixed page button.
2. In the Pages per Document field, enter the number of pages in a document.
3. Please skip to “To define page dimensions:” on page 70. (The following paragraphs discuss variable-length documents.)

Variable-Length documents

If your data pages vary in length, such as bank account activity, you must specify when to start a new document. A start-of-document indicator specifies when to start a new document. If the data varies to the point that one start-of-document indicator is insufficient, you can define variable-length documents with up to three start-of-document indicators.
For a variable-length document, the items involved are:

<table>
<thead>
<tr>
<th>Field or Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Document Attributes</strong></td>
<td>Select the Variable Page button to indicate that the number of pages per document vary. That is, one document could have 36 pages and another could have 800. The criteria for when to start a new document are determined by the remaining items in this group, including the page dimension fields.</td>
</tr>
<tr>
<td><strong>Start of Document #1 #2 and #3</strong></td>
<td>A value that COLD compares with values in the same place on every page (defined by line, column, and length). When COLD finds the start-of-document indicator value in the specified location, COLD starts a new document. You can specify up to three start-of-document indicators with Boolean operators to establish their logical relationships. The start-of-document option compares the current page to the previously-processed page, as opposed to comparing with the first page in the document.</td>
</tr>
<tr>
<td><strong>Line</strong></td>
<td>Defines the line where COLD looks for the value to determine where a new document begins.</td>
</tr>
<tr>
<td><strong>Column</strong></td>
<td>Defines the column where COLD looks for the value to determine where a new document begins.</td>
</tr>
<tr>
<td><strong>Length</strong></td>
<td>The length tells COLD how many characters are in the start-of-document indicator. After the length count, COLD starts looking for a new start-of-document indicator. The indicator is limited to a maximum of 150 characters. An indicator can be as many characters as the specified line, minus 1. Column 1 is always reserved for the channel control character.</td>
</tr>
<tr>
<td><strong>Boolean</strong></td>
<td>COLD activates the Boolean field at the end of the Start of Document #1 fields when you select the Start of Document #2 button. When you select the Start of Document #3 button COLD activates the Boolean field at the end of the Start of Document #2 fields. You can use the Boolean operators, <strong>and</strong> and <strong>or</strong>, to further clarify where COLD is to start a new document.</td>
</tr>
</tbody>
</table>

For each start-of-document indicator, you define the indicator's location by line, column, and length. For the second and third start-of-document indicators, you also define the Boolean operators, **and** or **or**.
For multiple start-of-document indicators, enter the start-of-document indicators' values from the top down (indicator #1, then #2, then #3). COLD reads the start-of-document indicator field values in the order indicated by the arrow:

```
```

Start-of-document indicators don’t have to be consecutive in the data. For example, you can achieve other combinations by specifying that the start-of-document indicator occurring first in the data is the third start-of-document indicator in the Report Format, as in the following illustration:

```
Start-of-Document indicator #3
Start-of-Document indicator #1
Start-of-Document indicator #2
```

Using this information, COLD searches for the specified indicators, compares them, and calculates when to start a new document.
If the start-of-document indicator does not change in 1,000 pages, COLD automatically starts a new document, using the same attributes as for the first document.

**Variable-length documents with a single start-of-document indicator**

The following example uses the *Acct* number as a start-of-document indicator. The *Acct* number begins in line 1, column 11, and is four characters long. COLD starts a new search in column 1, line 2. In this illustration, COLD finds a new start-of-document indicator after two more pages.
Variable-length documents with multiple start-of-document indicators

The three start-of-document indicators highlighted in the illustration below, Acct number (1ACT), the route (2RTE), and Cost Center number (3CCN), give an example of how you might use three start-of-document indicators.
Using the three indicators and the various Boolean operator combinations produces the following:

<table>
<thead>
<tr>
<th>Field 1</th>
<th>Oper.</th>
<th>Field 2</th>
<th>Oper.</th>
<th>Field 3</th>
<th>Starts a new document only when…</th>
</tr>
</thead>
<tbody>
<tr>
<td>1ACT</td>
<td>or</td>
<td>2RTE</td>
<td></td>
<td></td>
<td>either field changes.</td>
</tr>
<tr>
<td>1ACT</td>
<td>and</td>
<td>2RTE</td>
<td></td>
<td>3CCN</td>
<td>both fields change.</td>
</tr>
<tr>
<td>1ACT</td>
<td>or</td>
<td>2RTE</td>
<td>or</td>
<td>3CCN</td>
<td>any of the three fields changes.</td>
</tr>
<tr>
<td>1ACT</td>
<td>and</td>
<td>2RTE</td>
<td>and</td>
<td>3CCN</td>
<td>all three fields change.</td>
</tr>
<tr>
<td>(1ACT and 2RTE)</td>
<td>or</td>
<td>3CCN</td>
<td></td>
<td></td>
<td>both fields 1 and 2 change, or when field 3 changes.</td>
</tr>
<tr>
<td>(1ACT or 2RTE)</td>
<td>and</td>
<td>3CCN</td>
<td></td>
<td></td>
<td>either field 1 or field 2 changes, and field 3 changes too.</td>
</tr>
</tbody>
</table>

**To define a variable-length document:**

Use the following illustration as an example for the procedures:

1. In the Document Attributes section, click the **Variable page** button.

2. In the Start of Document #1 Line field, enter the line number of the start-of-document indicator. (On the illustration, line six (6).)
Preparing for an import job

Define report format

3 In the Start of Document #1 Column field, enter the column number where the start-of-document indicator begins. (On the illustration, column six (6).)

4 In the Start of Document #1 Length field, enter the indicator length. (On the illustration, 7 including the hyphen.) If you are defining only one start-of-document indicator, skip to “To define page dimensions:” on page 70.

5 For the second start-of-document indicator, click the Start of Document #2 button.

6 Click the drop-down list arrow in the same row as the Start of Document #1. Select a Boolean operator, and or or.

7 Repeat steps 2, 3, and 4 to enter the line, column, and length information for Start of Document #2. If you are defining only two start-of-document indicators, skip to “To define page dimensions:” on page 70.

8 For the third start-of-document indicator, click the Start of Document #3 button.

9 Click the drop-down list arrow in the same row as the Start of Document #2. Select a Boolean operator, and or or.

10 Repeat steps 2, 3, and 4 to enter the line, column, and length information for Start of Document #3.
Page dimensions

Page dimension information is used with both fixed-length and variable-length documents to define the amount of text that will fit on a page. Page dimensions are described by lines per page, starting output column, and print text width.

The items for describing page dimensions are:

<table>
<thead>
<tr>
<th>Field or Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines per page</td>
<td>Specifies the number of lines per page.</td>
</tr>
<tr>
<td>Starting output column</td>
<td>The first column of data to save to optical disk. Because the first column is reserved for the channel control character, the default is column 2.</td>
</tr>
<tr>
<td>Print text width</td>
<td>The number of characters to print beginning with the starting output column.</td>
</tr>
</tbody>
</table>

To define page dimensions:

1  In the Lines Per Page field, enter the maximum number of lines to print on one page.

A page can contain from one to a maximum of 150 lines. Lines that are partially filtered and those that are formatted as double- and triple-spaced count toward this maximum.

If the lines are too long to display in the window when you view COLD documents after committal, you can scroll the text or enlarge the window so that all lines display.
Preparing for an import job
Define report format

2 In the Starting Output Column field, enter the column number in which to begin printing. This applies to all lines of data that will be committed to optical disk. The default is 2, since the first character in a line is considered a channel control character.

3 In the Print Text Width field, enter the number of columns to print.

COLD permits a maximum of 256 characters per line. By entering a value of less that 256 in the Print Text Width field, you can print part of a line. To print part of a line, enter the number of characters that you want to print, beginning with the starting output column. Column 1 is reserved for the channel control character. So, if you enter 50 in the Print Text Width field, and you have 2 defined in the Starting Output Column field, columns 2 through 51 will print.

Define Committal Attributes

The Committal Attributes information controls how the document is committed. The following paragraphs describe the Committal Attributes fields and the information that you can specify.

<table>
<thead>
<tr>
<th>Committal Attributes</th>
<th>Document Class: SprngWtr</th>
<th>Indexes...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Table of Contents</td>
<td>Document Class:</td>
<td>Indexes...</td>
</tr>
<tr>
<td>Enable Page Compression</td>
<td>Document Class:</td>
<td>Indexes...</td>
</tr>
</tbody>
</table>
Preparing for an import job
Define report format

The items involved in this process are:

<table>
<thead>
<tr>
<th>Field or Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Table of Contents</td>
<td>Selecting this button specifies that COLD is to create a table of contents. You must specify more information about the table of contents by using the Table of Contents option from the File menu, which defines the appearance and function of the table of contents in the document.</td>
</tr>
<tr>
<td>Enable Page Compression</td>
<td>Selecting this button specifies that page compression be used. This button turns text compression on or off in the COLD document. Even with page compression turned off, COLD compresses trailing blanks and blank lines by default.</td>
</tr>
<tr>
<td>Document Class</td>
<td>A document class is required for every Report Format. Click the down arrow next to this field to display a list of the available document classes. Select a document class to use for the Report Format.</td>
</tr>
<tr>
<td>Indexes</td>
<td>Selecting this button displays the indexes associated with the document class displayed in the Document Class field. Click the Indexes button to select an index to use with the document class and to define indexing information.</td>
</tr>
</tbody>
</table>

The following pages explain these fields and buttons in more detail.

Enable table of contents

To generate a table of contents, click Enable Table of Contents button on the Define Report Format dialog box. This activates the Table of Contents option on the Edit menu. You must also specify the location of the table of contents identifier.

See “To generate a table of contents:” on page 77 for the actual procedures.
COLD builds the table of contents after processing the last page of a document. When you retrieve the document, COLD displays the table of contents first. From one to three tables of contents can be included at the beginning of a document. Each table of contents page counts as one page in the document.

COLD arranges the table of contents page(s) based on the number of its entries. COLD formats the entries into four columns, making it possible to display all the entries without scrolling. The following table explains the logic that COLD uses to format the table of contents.

<table>
<thead>
<tr>
<th>Number of Entries</th>
<th>Number of Rows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less than 300</td>
<td>75</td>
</tr>
<tr>
<td>300 or more but less than 599</td>
<td>150</td>
</tr>
<tr>
<td>More than 599</td>
<td>250</td>
</tr>
</tbody>
</table>

**Table of contents identifier**

If you select Enable Table of Contents, you must specify the location of the table of contents identifier. The table of contents identifier is a string of characters in the same place on each page.

When you generate a table of contents for a document consisting of multiple pages, COLD looks for this string of characters. Every time the string of characters changes, COLD adds the new characters—and associated page number—to the table of contents. This string, the table of contents Identifier, can be up to 30 characters long.
Preparing for an import job
Define report format

A COLD document can have a maximum of 1,000 pages and can have a maximum of three tables of contents. Each table of contents reduces the number of data pages in the COLD document. So, with one table of contents, a COLD document has a maximum of 999 data pages. With two tables of contents, the maximum is 998 pages. And, with three tables of contents, the 997 is the maximum number of pages.

Table of contents keys
For the first table of contents, COLD lists the table of contents keys and page numbers in the order in which they appear in the data. For COLD to list the table of contents in alphabetic or numeric order, the data must be sorted before it is imported or written to tape. You can use the first and last table of contents keys as index values if the data is sorted on the first TOC indicator only. For example, if your first TOC indicator on a page is a zip code, you can use the first and last zip code as a range of zip codes.

You can specify that COLD create up to three tables of contents per COLD document. Each table of contents can be based on a different key value. For example, table number one might list last names, table number two might list job titles, and table number three might list payroll numbers.
Table of contents layout

The index key determines the entries that will be on each table of contents page. The order of entries on the first table of contents is based on the order of entries within the document, in other words, page order. Second and third table of contents pages will contain entries based on the sorted order of their associated key values. The first key value on a page is the only one used for indexing.

For example, you specify the table of contents index keys as:

Last name (first key)
Job title (second key)
Social security number (third key)

The document contains this information:

<table>
<thead>
<tr>
<th>Last Name</th>
<th>Job Title</th>
<th>SSN</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adams</td>
<td>Product Engineer</td>
<td>321549987</td>
<td>4</td>
</tr>
<tr>
<td>Anderson</td>
<td>Manager, CS</td>
<td>123456789</td>
<td>5</td>
</tr>
<tr>
<td>Ball</td>
<td>Manager, QA</td>
<td>765444437</td>
<td>6</td>
</tr>
<tr>
<td>Smith</td>
<td>Programmer</td>
<td>125678987</td>
<td>7</td>
</tr>
</tbody>
</table>
Preparing for an import job

Define report format

The first table of contents, based on Last Name, could look like the following table. This document has a second and third table of contents, so the page numbers start at page 4. The first table of contents is based on the order of the entries within the document.

<table>
<thead>
<tr>
<th>Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adams</td>
<td>4</td>
</tr>
<tr>
<td>Anderson</td>
<td>5</td>
</tr>
<tr>
<td>Ball</td>
<td>6</td>
</tr>
<tr>
<td>Smith</td>
<td>7</td>
</tr>
</tbody>
</table>

The second table of contents (sorted on job title) might look like this:

<table>
<thead>
<tr>
<th>Job Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager, CS</td>
<td>5</td>
</tr>
<tr>
<td>Manager, QA</td>
<td>6</td>
</tr>
<tr>
<td>Product Engineer</td>
<td>4</td>
</tr>
<tr>
<td>Programmer</td>
<td>7</td>
</tr>
</tbody>
</table>

The third table of contents (sorted on social security number) might look like this:

<table>
<thead>
<tr>
<th>Social Security</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>123456789</td>
<td>5</td>
</tr>
<tr>
<td>125678987</td>
<td>7</td>
</tr>
<tr>
<td>321549987</td>
<td>4</td>
</tr>
<tr>
<td>765444437</td>
<td>6</td>
</tr>
</tbody>
</table>
To generate a table of contents:

1 In the Committal Attributes section, click the Enable Table of Contents button. This activates the Table of Contents command on the Edit menu.

2 From the Edit menu, select Table of Contents to display the Table of Contents dialog box.

3 In the Table of Contents #1 Line field, enter the line number where COLD can find the table of contents identifier.

4 In the Table of Contents #1 Column field, enter the column number where the table of contents identifier begins.
5 In the Table of Contents #1 Length field, enter the length (1 to 30) of the table of contents identifier.

If you want only one table of contents, proceed to the next step. For second and third tables of contents, repeat steps 2, 3, and 4 for the Table of Contents #2 and #3 Line, Column, and Length fields.

6 To specify a background template for the table of contents pages, click the down arrow next to the Template field. COLD displays a list of template files available on your system.

7 Click on the desired template name to select it.

8 To define the font, typeface style, characters per inch, lines per inch, and top and left margin offsets for the text that uses this template, click the Page Setup button. If you do not select Page Setup, COLD uses default settings for these parameters. The default settings are based on how the raw data is formatted.

For details on Page Setup settings and information on how COLD applies the default settings, see “The Page Setup dialog box” on page 121.

9 Click the OK button to exit from the Page Setup window and return to the Table of Contents dialog box.

10 To accept the Table of Contents values that you have entered and exit from the window, click the OK button. COLD returns you to the main Define Report Format window.
Enable page compression

Even when page compression is off, COLD still compresses trailing blanks and blank lines. If you turn page compression on, COLD compresses the text as well.

With compression turned off, you can expect a compression ratio of approximately 2:1 (raw data versus processed data). With compression turned on, you might get compression ratios as high as 4:1. These ratios are estimates and are normally possible only with longer documents.

To enable/disable page compression:

Click the Enable Page Compression button. The center of the button depresses to indicate that compression is on.

Click the button again to turn it off. The center of the button pops up to indicate that compression is off.

Designate a document class

A Report Format must have a document class, and you can only choose document classes that are available at the time that you are creating the Report Format. Each Report Format can use a different document class, or all of them can use the same one.
Preparing for an import job
Define report format

Scanned documents and COLD documents can use the same document class. To distinguish COLD documents from scanned documents in the same document class when looking at a Query Match Report, look at the document type. COLD documents committed without a background template are type TEXT. COLD documents committed with a background template are type MIXED. Keep in mind, however, that the types TEXT and MIXED are also used for documents other than COLD documents. For details on document types, see the FileNet Image Services System Administrator’s Handbook. To download IBM FileNet documentation from the IBM support page, see “Accessing IBM FileNet documentation” on page 16.

To specify a document class:

In the Define Report Format window, click the down arrow next to the Document Class field. Scroll through this list until you find the desired document class name. Click on the document class name to select it.

If you need to modify a document class’s index or add an index to a document class, you must do so through FileNet Image Services Database Maintenance. (See the FileNet Image Services System Administrator’s Handbook for more information. To download IBM FileNet documentation from the IBM support page, see “Accessing IBM FileNet documentation” on page 16.) In COLD, you can modify the index source, the date mask, the index value if it is a constant, and its location in the document, if it is a variable.

Document class index names

After selecting a document class name, specify the indexes in that document class to associate with your COLD data.
Click the Indexes button to open the Document Class Information dialog box. From this dialog box you can select from a list of index names that belong to the selected document class. Use the Name, Type, and Source columns as a guide to your selection.

COLD permits a maximum of 224 indexes per Report Format. If you select a document class with more than 224 indexes, the program ignores any above 224.
Preparing for an import job
Define report format

The index-related fields in the Document Class Information window are Index Name, Type, and Source.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index Name</td>
<td>Index Name is the name given to the index when it was created in the FileNet Image Services Database Maintenance application. You cannot modify the Index Name.</td>
</tr>
<tr>
<td>Type</td>
<td>Type is assigned in the FileNet Image Services Database Maintenance application. The index field types that COLD supports are: string, numeric, menu, and date. For details on field types, please refer to the System Administrator’s Handbook. To download IBM FileNet documentation from the IBM support page, see &quot;Accessing IBM FileNet documentation&quot; on page 16.</td>
</tr>
<tr>
<td>Source</td>
<td>Source is where or how the index value is found in the document. Source can be used for all index types: string, numeric, date, and menu. Source can be: document, constant, keyword, or TOC.</td>
</tr>
</tbody>
</table>

The table below shows the relationship between the index type and the source values.

<table>
<thead>
<tr>
<th>Index Type</th>
<th>Default Source Value</th>
<th>Other Source Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>No Value</td>
<td>Constant&lt;br&gt;Document&lt;br&gt;Keyword&lt;br&gt;TOC (if specified in Report Definition)</td>
</tr>
<tr>
<td>Numeric</td>
<td>No Value</td>
<td>Constant&lt;br&gt;Document&lt;br&gt;Keyword</td>
</tr>
</tbody>
</table>

May 2011
FileNet Image Services COLD Handbook, Version 4.2
### Preparing for an import job

Define report format

<table>
<thead>
<tr>
<th>Index Type</th>
<th>Default Source Value</th>
<th>Other Source Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu</td>
<td>No Value</td>
<td>Constant Document Keyword</td>
</tr>
<tr>
<td>Date</td>
<td>Run Date</td>
<td>Constant Document Keyword</td>
</tr>
</tbody>
</table>
Preparing for an import job
Define report format

Attention
Valid menu items are defined in Database Maintenance.

If the value—based on “document” or “keyword”—that COLD assigns to a Menu index type is invalid, COLD automatically defaults to the first valid Menu item. COLD then generates a warning in the Log file.

If the value that COLD assigns to a Numeric or Date index type is invalid, and an override date mask is not defined in the Indexing Information window (Date Mask field), COLD accepts the value but issues a warning in the Log file.

Specify indexing information

When you select an index name in the Document Class Information dialog box, the Indexing Information dialog box appears as shown on the following page.

It might be helpful to refer to this screen as you continue through this section.
Preparing for an import job
Define report format

Index Information

- Name: Summary
- Type: String

Source Parameters

- Source: Document
- Column: 20
- Line: 10

Index Identification Method

- Length
- Token Concatenation
- Filter Mask

Cancel
Preparing for an import job
Define report format

The following pages provide procedures to describe the specific indexing information for each source value: constant (page 87), document (page 90), run date (page 92), no value (page 93), 1st & last TOC page (page 94), and keyword (page 95).

The following tables describe the index types that you can associate with the index value source:

<table>
<thead>
<tr>
<th>Source</th>
<th>Index Type</th>
<th>Source</th>
<th>Index Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>String, Numeric, Menu, Date</td>
<td>No Value</td>
<td>String, Numeric, Menu</td>
</tr>
<tr>
<td>Document</td>
<td>String, Numeric, Menu, Date</td>
<td>Run Date</td>
<td>Date</td>
</tr>
<tr>
<td>Keyword</td>
<td>String, Numeric, Menu, Date</td>
<td>1st TOC and Last TOC Page</td>
<td>Only available when Report Definition TOC is on.</td>
</tr>
</tbody>
</table>
To specify indexing information—Source: Constant:

Use Constant with index types String, Numeric, Menu, and Date. A constant value is the same value throughout the document.

1. In the Document Class Information dialog box, click an index name.

2. Click the Modify button to display the Indexing Information dialog box, which holds index information, source parameters, and the index identification method.

3. Choose the source of the index value by clicking the down arrow next to the Source field and selecting Constant.

When you select Constant in the Source field, COLD enables the Constant/Date Mask field.

4. For the index type that you want to use, perform the actions described in the corresponding bulleted item below. Enter the values in the Constant/Date Mask Field.

- **String**—Enter the value. The maximum length is defined in FileNet Image Services Database Maintenance. Only 10 characters display in this window. The Query Match Report displays all the characters after committal.

- **Numeric**—Enter the value. The value can only be numeric. If a mask is defined in FileNet Image Services Database Maintenance, the value must conform to the mask. The maximum length is defined in FileNet Image Services Database Maintenance. Only 10 characters display in this window. The Query Match Report displays all the characters after committal.

- **Menu**—Click the down arrow next to the Menu Items field to select from a list of menu item values.
Preparing for an import job
Define report format

- **Date**—Enter the date. If a mask is defined in FileNet Image Services Database Maintenance, the value must conform to the mask. See the following paragraphs for more information on dates. For information on the date masks residing on the FileNet system, see “FileNet system date masks” on page 195.

If you use a two-digit date mask, COLD displays the following dialog box when you enter the date.

![Two Digit Year dialog box](image)

In this dialog box, you can choose to always pre-append either 19 or 20 to the two-digit year, or you can enter a threshold year where COLD pre-appends 19 to the year following the threshold year and all intervening years until 2000.
If you select Threshold Year, you can designate which year you want COLD to start applying the 19. For example, you might want all two-digit years pre-appended with 19 beginning with the year that your company started. If your company started in 1968, you would use 67 as the threshold year. COLD then pre-appends 19 to all two-digit years from 68 through 99 inclusive, and pre-appends all two-digit years from 00 through 67 with 20.

The following table gives examples of how the threshold year logic works:

<table>
<thead>
<tr>
<th>Threshold Year</th>
<th>Pre-append with 19</th>
<th>Pre-append with 20</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>17 through 99</td>
<td>00 through 16</td>
</tr>
<tr>
<td>67</td>
<td>68 through 99</td>
<td>00 through 67</td>
</tr>
<tr>
<td>83</td>
<td>84 through 99</td>
<td>00 through 83</td>
</tr>
</tbody>
</table>

5 Click the OK button. COLD returns you to the Document Class Information window and displays your changes in the Source column.

6 To save the indexing information, click on the OK button. This returns you to the Define Report Format window.

7 In the Define Report Format window, select Save from the File menu.
To specify indexing information—Source: Document:

Use Document with index types String, Numeric, Menu, and Date.

1. Click an index name in the Document Class Information dialog box.

2. Click the Modify button to display the Indexing Information dialog box, which holds index information, source parameters, and the index identification method.

3. Choose the source of the index value by clicking the down arrow next to the Source field and selecting Document.

When you select Document as the source, COLD enables the Constant/Date Mask, Page, Line, Column, and ID Methods (Length, Token Concatenation, Filter Mask) fields.

The values that you enter in these fields indicate where COLD is to find the index value in the document. The data items found at these locations must conform to the index field type.

4. To use the default mask defined in FileNet Image Services Database Maintenance, leave the field blank and tab to the next field. To override the default mask, enter the mask you want to use. For information on using a two-digit year, see page 88.

5. Enter the document Page number where COLD can find the index value. This is a required value.

6. Enter the Line number where COLD can find the index value.

7. Enter the Column number where COLD can find the index value.

8. Select either the Bytes or Characters radio button.
Preparing for an import job

Define report format

a  For single-byte (NLS) language support, select Bytes (default).

b  For multi-byte (NLS) support, for languages such as Japanese, you can select Bytes or Characters.

**Tip**

Refer to, “**Multi-byte character support**” on page 27 to see the necessary requirements for multi-byte character support.

9  In the Index Identification Method section of the Indexing Information dialog box, select one of the following methods for identifying the index value. See “**Specify index identification method**” on page 97 for more information.

- **Length**—select the length button, enter the length of the index value, and select either the Bytes or Characters radio button.
  - For single-byte (NLS) language support, select Bytes (default).
  - For multi-byte (NLS) support, for languages such as Japanese, you can select Bytes or Characters.

- **Token Concatenation**—select the Token Concatenation button and enter the Token Count and Token Separator for the index value. For details, see “**To obtain index values by token concatenation:**” on page 99.

- **Filter Mask**—select the Filter Mask button and enter the Filter Mask for the index value. For details, see “**To obtain index values by filter mask:**” on page 100.

10  Click the OK button. COLD returns you to the Document Class Information window and displays your changes in the Source column.
Preparing for an import job
Define report format

11 To save the indexing information, click on the OK button. This returns you to the Define Report Format window.

12 In the Define Report Format window, select Save from the File menu.

To specify indexing information—Source: Run Date:
Use Run Date with index type Date only. Using Run Date causes COLD to use the system date on the day you run the COLD import job. COLD formats the date as it is specified in FileNet Image Services Database Maintenance.

1 Click an index name in the Document Class Information dialog box.

2 Click the Modify button to display the Indexing Information dialog box, which holds index information, source parameters, and the index identification method.

3 Choose the source of the index value by clicking the down arrow next to the Source field and selecting Run Date.

When you select Run Date in the Source field, COLD displays the Constant/Date Mask field.

4 To use the default mask defined in Database Maintenance, leave the field blank and tab to the next field. To override the default mask, enter the date you want to use. For information on using a 2-digit year, see page 88.

To determine which date mask to use, you can either run the User Index Report from FileNet Image Services Database Maintenance or enter a date mask that matches the data. See the FileNet Image Services System Administrator’s Handbook for more detailed information.
To download IBM FileNet documentation from the IBM support page, see “Accessing IBM FileNet documentation” on page 16.

5. Click the OK button. This returns you to the Document Class Information window and displays your changes in the Source column.

6. To save the indexing information, click on the OK button. This returns you to the Define Report Format window.

7. In the Define Report Format window, select Save from the File menu.

**To specify indexing information—Source: No Value:**

Use No Value with index types String, Numeric, and Menu. No value indicates that an index is not used in your COLD data. Using No Value causes COLD to ignore the index. No Value cannot be used with index type Date.

1. Click an index name in the Document Class Information dialog box.

2. Click the Modify button to display the Indexing Information dialog box, which holds index information, source parameters, and the index identification method.

3. Choose the source of the index value by clicking the down arrow next to the Source field and selecting No Value.

4. To save the indexing information, click on the OK button. This returns you to the Define Report Format window.

5. In the Define Report Format window, select Save from the File menu.
Preparing for an import job

Define report format

To specify indexing information—
Source: 1st TOC Page & Last TOC Page:

The 1st TOC page and Last TOC page option is available only if the index field is a string type, and if you selected the Yes button for Enable Table of Contents. When the table of contents entries consist of a sequence of values in ascending or descending order, the first and last values are useful for document retrieval.

Attention

The 1st TOC page and Last TOC page option refers only to the first table of contents parameter entered. Second and third tables of contents cannot be used.

1. Click an index name in the Document Class Information dialog box.

2. Click the Modify button to display the Indexing Information dialog box, which holds index information, source parameters, and the index identification method.

3. Choose the source of the index value, by clicking the down arrow next to the Source field and selecting 1st TOC Page and Last TOC Page.

4. Click on the OK button. COLD returns you to the Document Class Information window and displays your changes in the Source column.

5. To save the indexing information, click on the OK button. This returns you to the Define Report Format window.

6. In the Define Report Format window, select Save from the File menu.
To specify indexing information—Source: Keyword:

Use the keyword index type to capture an index value that is not in the same place on every page. For example, the number of invoice line items might vary from invoice to invoice causing the column totals to fall on a different line on each invoice. If the words “Invoice Total” always precede the index value, you could specify that COLD find “Invoice Total” and use the next “word” as an index value. To do this, you specify offset coordinates for COLD to use in finding the index value. For examples and explanations of offsets, see “Find index values using offset coordinates” on page 101.

To use an index value that is in the same place on every page, see “To specify indexing information—Source: Document:” on page 90.

**Attention**

In both the Preview and the Import functions, COLD terminates if it cannot find the keyword literal in a document. When termination occurs, COLD displays a message in the Preview or Import window, whichever process you are attempting.

1. In the Document Class Information dialog box, click an index name.

2. Click the Modify button to display the Indexing Information dialog box, which holds index information, source parameters, and the index identification method.

3. Choose the source of the index value, by clicking the down arrow next to the Source field and selecting Keyword.

When you select Keyword in the Source field, COLD displays the Literal field. The Constant/Date Mask field is replaced by the Literal field when Keyword is selected.
4 In the Literal field, enter the keyword you want to find.

5 In the Page field, enter the page number on which COLD is to find the keyword.

**Tip** If you leave the Line and Column fields blank, COLD searches the current page for the keyword. Only leave these fields blank if the keyword is not in the same place on every page.

6 In the Line field, enter the line where COLD can find the keyword. This step is optional.

7 In the Column field, enter the column where COLD can find the keyword.

8 Select the value of the Horizontal Offset.

   - To specify how many words **after** the keyword to find the index value, click the right arrow in the Horizontal Offset scale.
   
   - To specify how many words **before** (minus) the keyword to find the index value, click the left arrow in the Horizontal Offset scale.

9 Select the value of Vertical Offset.

   - To specify how many lines **after** the keyword to find the index value, click the right arrow in the Vertical Offset scale.
   
   - To specify how many lines **before** (minus) the keyword to find the index value, click the left arrow in the Vertical Offset scale.
Preparing for an import job
Define report format

10 Enter the ID Method of the index value. See “Specify index identification method” on page 97 for more information.

- **Length**—select the length button and enter the length of the index value.
- **Token Concatenation**—select the Token Concatenation button and enter the Token Count and Token Separator for the index value. For details, see “To obtain index values by token concatenation:” on page 99.
- **Filter Mask**—select the Filter Mask button and enter the Filter Mask for the index value. For details, see “To obtain index values by filter mask:” on page 100.

11 Click the OK button. This returns you to the Document Class Information window and displays your changes in the Source column.

12 To save keyword information, click on the OK button. This returns you to the Define Report Format window.

13 In the Define Report Format window, select Save from the File menu.

**Specify index identification method**

Index values can be identified by length, token concatenation, or filter mask. Using length as an index identification method is more limited in capability than the other two methods (token concatenation or filter mask). The length method limits you to whatever text the software finds within the specified length.

The token concatenation or filter mask methods allow you to manipulate the index value prior to storing it.
To obtain index values by length:

Use the Length option to find a specific, non-changing length of text. With the length method, you obtain index values from the document text using a length parameter with either keyword or document as index sources.

**Attention**
You must select this option for multi-byte character support.

1. To choose length as the index identification method, select the Length button.

2. Enter the length of the keyword or document location to be indexed and select either the Bytes or Characters radio button.
   - If the index source is Keyword, select Bytes (default) for single-byte (NLS) language support.
   - If the index source is Document, select either the Bytes or Characters radio button.

**Attention**
For multi-byte (NLS) support, for languages such as Japanese, select Characters.

3. Click the OK button. This returns you to the Document Class Information window.

4. To save the index value information, click on the OK button. This returns you to the Define Report Format window.

5. In the Define Report Format window, select Save from the File menu.
To obtain index values by token concatenation:

Use Token Concatenation to find a specific number of words and strip the blank spaces from around them. You can also use a separator, which is an optional character that can be inserted between the words, such as a comma. Without a separator, the words will have no spaces or separators between them.

With this method, you specify a set of characters, called a token count, to obtain an index value. Token Count is the number of words, or set of characters delimited by white space, that you want to use as the index value. You can use from one (1) to 24 words. It indicates where to find an index value in relation to the specified document or keyword.

In addition, you can also specify a token separator of one character between each token during concatenation. This provides greater flexibility in setting index values. The Token Separator can be any alphanumeric or punctuation character.

For example, in the following text, you use the keyword NAME with a horizontal offset of one word. You specify a token count of two and no token separator:

NAME: Smith, John

After token concatenation, the index value is SmithJohn. If you use a comma as a token separator, the index value after token concatenation is Smith,John.

1. To choose token concatenation as the index identification method, select the Token Concatenation button.

2. Enter the value for the Token Count (number of words).
Preparing for an import job
Define report format

3. Enter the character to use for the Token Separator.

4. Click the OK button.
   COLD returns you to the Document Class Information window.

5. To save token concatenation information, click on the OK button. This returns you to the Define Report Format window.

6. In the Define Report Format window, select Save from the File menu.

To obtain index values by filter mask:
A filter mask identifies characters that you want to keep and the characters you want to remove from an index value. The filter mask is applied to the specified keyword or data. This method is primarily for converting data that is a combination of numeric and non-numeric characters for storage as a numeric index, such as a social security or telephone number.

The filter mask uses the plus character (+) to indicate inclusion. All other characters are ignored. The plus character (+) retains the corresponding data character for the index value, while any other character removes the corresponding data character from the index value. You might want to use the minus character (-) as the character to indicate removal.

In the following example, you want the numeric index Phone Number to store the actual telephone number. However, the phone number in the COLD document appears like this, with non-numeric characters:

   (800) 123-4546
You could use this filter mask to remove the parentheses, extra spaces, and the dash:

- + + + - + + + - + + + +

After COLD applies the filter mask, the value stored for the Phone Number index is:

800123456.

1. To choose filter mask as the index identification method, select the Filter Mask button.

2. Enter the index mask you want to use.

3. Click the OK button. COLD returns you to the Document Class Information window.

4. To save the index mask, click on the OK button. This returns you to the Define Report Format window.

5. In the Define Report Format window, select Save from the File menu.

Find index values using offset coordinates

To find the index value using keyword, COLD uses offset coordinates relating to the keyword. You specify the offset coordinates by counting the lines and words beginning with one (1) as the offset from the keyword location of zero (0). Anytime you tell COLD to back up from the keyword (number of words and lines), you must include a minus in the location.
The following examples and illustrations explain how to express the offset coordinates (–50 to 50 beginning with 1) from the keyword using various value locations. The keyword coordinates are 0,0.

Attention

COLD considers a **word** as a string of characters with a space on either end. When COLD counts words, the number of spaces between words is ignored. This example counts as three words:

```
Cost Center 1012-4BJKS
```

**Offsets 1,0**

In this coordinate, the index value is the next word after the keyword (zero point) and on the same line as the keyword.
Preparing for an import job

Define report format

Offsets –1,0
In this coordinate, the index value is the word immediately before the keyword and on the same line as the keyword.

Offsets 1,2
In this coordinate, the index value is the next word after the keyword and two lines below the keyword.
Preparing for an import job

Define report format

Offsets 0,2
In this coordinate, the index value is the next word after the keyword and two lines below the keyword.

Offsets 3,2
In this coordinate, the index value is the third word after the keyword and two lines below the keyword.
Offsets –3,–2
In this coordinate, the index value is the third word before the keyword and two lines above the keyword.
Specify filtering, multiple templates, and tables of contents

Use the Edit Menu commands in the Define Report Format window as explained in the table below:

<table>
<thead>
<tr>
<th>Edit Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table of Contents</td>
<td>Select this option from the Edit menu to indicate the location of the table of contents key or keys. When a key changes, COLD puts it and its associated page number in the table of contents. You can also select a background template for each of the table of contents pages.</td>
</tr>
<tr>
<td>Multiple Templates</td>
<td>Select Multiple Templates from the Edit menu to add the background template definitions that COLD is to use on specific pages for this Report Format.</td>
</tr>
</tbody>
</table>
| Document Format       | This Edit menu command has the following options:  
                          - Page filter  
                          - Line filter  
                          - Default templates  
                          - Add, modify, or delete templates  
                          These options are explained on the following pages.                                                                                     |

**Page filter**

You can filter pages from committal using the Edit menu's Document Format command. For example, you can omit a page containing only control information or indexing information. You specify the location of a search literal identifying this page. Page filtering is applied to the unformatted data. So, if page 3 is selected during the filtering process, it is not page 3 of every document, but page 3 of the unformatted text.
Preparing for an import job
Define report format

From the Edit menu, select Document Format to display the Document Format window.
Preparing for an import job

Define report format

Consider that COLD includes filtered pages in the page count. For example, you might decide to filter out page two, but you want COLD to extract a value from page three of a document. The program still extracts the information from the third page, because page two will not be filtered out until after COLD processes the data. For details about how COLD processes and filters data, please see “COLD formatting during data processing” on page 173.

To extract indexing values from filtered pages:

If you want COLD to perform indexing on filtered pages, you must add an environment variable to either your .profile file or the /etc/rc.initfnsw file.

- If the FileNet software starts automatically when you boot your system, then add the line below to the /etc/rc.initfnsw file.

- If you start the FileNet software yourself, or if you log on as “root” then add the line below to the .profile file.)

Enter this line anywhere after the “# Start FileNet IMS” line:

```
COLD_IGNORE FILTERED_PAGES=0
```

Also add this information at the end of the “export” line near the end of the same file.

If the environment is set as follows, COLD does not perform indexing on filtered pages.

```
COLD_IGNORE FILTERED_PAGES=1
```
Preparing for an import job
Define report format

To filter pages:
Enter the following information in the Document Format window’s Page Filter section:

1 In the Line field, enter the line number where COLD can find the page filter literal.
2 In the Column field, enter the column number where the page filter literal begins.
3 In the Literal field, enter the page filter literal value.
   The maximum length of a page filter literal is 16 characters. COLD filters all pages on which this literal occurs. COLD automatically records the length in the Length field (next to the Literal field).
4 To save your page filtering information, click on the OK button. This returns you to the Define Report Format window.
5 From the File menu in the Define Report Format window, select Save.
   The following paragraphs explain the Line Filter and Template sections in the Document Format window.
To filter a single page:

This option is only available if your Report Format specifies variable-page documents. Enter the following information in the Document Format window’s Line Filter section:

2. In the Page field, enter the page number to filter.
3. To save your page filtering information, click the OK button. This returns you to the Define Report Format window.
4. From the File menu in the Define Report Format window, select Save.

Line filter

COLD can extract information such as index values or a Report Format literal from a filtered line of data that ultimately does not appear in the final output. For example, you might want a social security number extracted from a line of data that includes other information that is not relevant to your report.

If you use filtered data in creating the table of contents or in indexing, the data does display in the table of contents and index.
Preparing for an import job
Define report format

You can filter lines in two ways:

- Line filtering by line number filters only one line per page, and only that line can be filtered for the entire Report Format. When filtering by line number, you can also filter part of a line.

- Line filtering by search literal filters out more than one line per page. COLD filters any lines containing the search literal in the specified location.

Consider that COLD includes filtered lines in the line count (as opposed to any channel control character that ignores a line). For details about how COLD processes and filters data, please see “COLD formatting during data processing” on page 173.

To filter a line by line number:

To accurately figure the line number to filter, run the Preview Document program with no line filtering. From the output window, identify the line number that you want to filter out. See “Preview documents” on page 134.

Enter the following information in the Document Format window’s Line Filter section:

1. Click the Single Line Filter button to activate the single line filter fields.

2. In the Line field, enter the line number to filter.

3. To save your line filtering information, click the OK button. This returns you to the Define Report Format window.

4. From the File menu in the Define Report Format window, select Save.
Preparing for an import job
Define report format

To filter lines by search literal:
Enter the following information in the Document Format window’s Line Filter section:

1. In the Column field, enter the column number in which the search literal begins.

Attention
Make sure that none of the filter buttons are selected. These filter buttons are the Single Line Filter, Single Page Filter, and Partial Line Filtering buttons. The search does not work properly if any are selected.
Preparing for an import job
Define report format

2 In the Literal field, enter the value that COLD searches for. This field takes a maximum of 16 characters. COLD automatically displays the length of the search literal in the Length field.

3 To save your line filtering information, click the OK button. This returns you to the Define Report Format window.

4 From the File menu in the Define Report Format window, select Save.

**To use partial line filtering:**
Enter the following information in the Document Format window’s Line Filter section:

1 To activate the Partial Line filtering fields, click on the Partial line filtering button.

2 In the Starting Column field, enter the column number where line filtering should start.

**Attention** If you leave this field blank, the entire line is removed.

3 In the Filter Text Width field, enter the number of characters to omit.

4 To save your line filtering information, click the OK button. This returns you to the Define Report Format window.

5 From the Edit menu in the Define Report Format window, select Save.
Select a default template

Use the Template field in the Document Format window to specify a default template for pages that do not have an associated template. For example, you might want to display a simple border and your company logo.

To use background templates for specific data pages, see “Add, modify, or delete templates” on page 115.

To select a default background template:

Enter the following information in the Document Format window’s Template section:

1. To display a list of the background template definitions on your system, click the down arrow next to the Template field.
2. Click the template of your choice to select it.
3. To define the text formatting for the pages using this template, click the Page Setup button.

Use Page Setup to define the font, typeface style, characters per inch, lines per inch, and top and left margin offsets. If you do not select Page Setup, COLD uses default settings. The default settings are based on the format of your data.

For details on Page Setup settings and information on how COLD applies the default settings, see “The Page Setup dialog box” on page 121.
Preparing for an import job

Define report format

4 Click the OK button. This returns you to the Document Format window.

5 Click OK to return to the Define Report Format window.

Add, modify, or delete templates

Use the Edit menu’s Multiple Templates command to select multiple background templates to display with specific data pages. You specify the line and column where COLD can find a literal that links that page to a background template. Whenever COLD finds this literal, it applies the template to that page. You can also use the Multiple Templates command on the Edit menu to add, modify, and delete templates from your Report Format file.

The same rules that apply to tables of contents (TOC) and data pages also apply to templates. Without a TOC, you can have a maximum of 1,000 pages in your template. If you select the Enable Table of Contents button in the Define Report Format window and specify one TOC, you can have 999 pages. With two TOCs you can have 998 pages. And, with three TOCs you can have 997 pages in the template.

CAUTION

COLD searches each page sequentially for the literal that identifies the template. On pages that contain multiple matches, only the first one is recognized. The program ignores subsequent matching literals on the page.

If an accidental match occurs—if COLD finds a literal that matches the wrong template—it still applies that template. Analyze your data carefully to make sure that no accidental matches can occur.
To add a template to a Report Format:

1. From the Edit menu, select Multiple Templates to display the Multiple Templates window listing the template definition files available on your system.

2. On the Available Template list, click on the template that you want to add to your Report Format. This action selects the template.

3. Click the Add button to display the Template Identifier window. COLD displays the selected template name in the Template Name field.
Preparing for an import job

Define report format

4 In the Line and Column fields, specify the line and column in the formatted data where COLD can find the literal for this template.

5 In the Literal field, enter the value. The maximum length of this field is 20 characters. COLD automatically records the length in the Length field when you exit the dialog box.

6 Click the Page Setup button to define the text formatting for the pages using this template.
Preparing for an import job
Define report format

Page Setup is where you define the font, typeface style, characters per inch, lines per inch, and top and left margin offsets. If you do not select Page Setup, COLD uses default settings. The default settings are based on the format of your data.

For details on Page Setup settings and information on how COLD applies the default settings, see “The Page Setup dialog box” on page 121.

7 After completing your entries, click the OK button. COLD returns you to the Multiple Templates window and displays the template in the Selected Templates box. If you have two matches, the first parameter’s template is chosen.

You can continue to add templates to your Report Format file.

8 To exit from this window, click the OK button. COLD returns you to the Define Report Format window.

9 In the Define Report Format window, select Save from the File menu.
Preparing for an import job
Define report format

To modify a template in a Report Format:

1. From the Edit menu, select Multiple Templates to display the Multiple Templates window with a list of the template definition files available on your system.

2. In the Selected Template List, select the template that you want to change.

3. Click the Modify button to display the Template Identifier dialog box.

4. Change any of the values in the line, column, or literal fields.

5. To change the font, style, characters per inch, lines per inch, or margin settings, click on the Page Setup button.

   For details on Page Setup settings and information on how COLD applies the default settings, see “The Page Setup dialog box” on page 121.

6. Click the OK button. COLD records your changes. You can continue to modify other templates.

7. To exit from this window, click the OK button. COLD returns you to the Define Report Format window.

8. In the Define Report Format window, select Save from the File menu.
To delete a template from a Report Format:

1. From the Edit menu, select Multiple Templates to display the Multiple Templates window listing the template definition files available on your system.

2. In the Selected Template List, select the template that you want to delete.

3. Click the OK button. COLD prompts you:

   Template “<template-name>” will be removed from the report. Are you sure?

4. To remove the template from the Report Format file, click the Yes button. The template name is removed from the Selected Template List, but is still available on your hard disk. You can continue to delete templates from your Report Format.

5. To exit from this window, click the OK button. COLD returns you to the Define Report Format window.

6. In the Define Report Format window, select Save from the File menu.
Preparing for an import job
Define report format

The Page Setup dialog box

In the Page Setup dialog box, you specify the font, typeface style, characters per inch, lines per inch, and top and left margins for pages in your document. The following paragraphs explain these steps.

The Page Setup function is especially useful for fine-tuning the appearance of your output data and positioning it correctly on the background template. You might need to experiment with the settings to position your data satisfactorily. Use the Preview Documents function or print a test copy to check how the data aligns with the template form. See “Preview documents” on page 134 for details.

You can access the Page Setup dialog box by clicking the Page Setup button from various dialog boxes as follows:

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>Possible Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table of Contents</td>
<td>Specify page setup values only for the table of contents page.</td>
</tr>
<tr>
<td>Template Identifier</td>
<td>Specify page setup values only for those pages where the selected template identifier appears.</td>
</tr>
<tr>
<td>Document Format</td>
<td>Specify page setup values for all pages in the document except the table of contents page. You can also specify page setup values for those pages in the body of the document to which you assigned a specific template (in the Template Identifier dialog box).</td>
</tr>
</tbody>
</table>

The following is an illustration of the Page Setup dialog box:
Preparing for an import job
Define report format

The following pages describe how you can specify page setup values or use COLD’s default page setup.
Font
For printing your data and table of contents pages, you can select one of the fonts that COLD provides, or you can leave the Default setting (shown in the table below) as is. The program selects fonts based on the conditions listed in the following table, which are in effect on most platforms.

Attention If you are going to configure your system for multi-byte data characters, you must select the Japanese font in this field.

<table>
<thead>
<tr>
<th>Conditions</th>
<th>Font Name</th>
<th>Pixel Width</th>
<th>Characters per Inch (Horizontal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>More than 85 characters per line.</td>
<td>Gothic 6</td>
<td>5</td>
<td>20.00</td>
</tr>
<tr>
<td>Has background template. More than 85 characters per line.</td>
<td>Gothic 8</td>
<td>6</td>
<td>16.67</td>
</tr>
<tr>
<td>Fewer than 86 characters per line.</td>
<td>Gothic 9</td>
<td>8</td>
<td>12.50</td>
</tr>
<tr>
<td>Has background template. Fewer than 86 characters per line.</td>
<td>Gothic 12</td>
<td>10</td>
<td>10.00</td>
</tr>
</tbody>
</table>

The four Gothic fonts are included with the COLD software. The Courier typeface is also provided in a variety of characters per inch and pixel widths.

Attention During document preview, the Gothic fonts display as the Courier typeface on most platforms. See the table on page 124 for a complete list of available Courier font sizes. Other FileNet applications might display the Gothic fonts using something other than Courier.
Preparing for an import job

Define report format

The Courier and Japanese fonts are equivalent to the Gothic typeface.

<table>
<thead>
<tr>
<th>Pixel Width</th>
<th>Characters per Inch (Horizontal)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>20.00</td>
</tr>
<tr>
<td>6</td>
<td>16.67</td>
</tr>
<tr>
<td>7</td>
<td>14.29</td>
</tr>
<tr>
<td>8</td>
<td>12.50</td>
</tr>
<tr>
<td>9</td>
<td>11.11</td>
</tr>
<tr>
<td>10</td>
<td>10.00</td>
</tr>
<tr>
<td>11</td>
<td>9.09</td>
</tr>
<tr>
<td>12</td>
<td>8.33</td>
</tr>
</tbody>
</table>

To select a font, click the down arrow next to the Font field in the Page Setup dialog box. Select the font of your choice.

**Lines/Inch**

You can select a value of six or eight lines per inch (LPI) for printing data and table of contents pages, or you can accept the default. If you accept the default, the data displays and prints with a standard line spacing (LPI) for the selected font.

To change lines per inch, click the down arrow next to the Lines/inch field. Select the setting of your choice.
Preparing for an import job
Define report format

Top/Left margin in inches
Your background templates might have borders or graphic objects that intrude on the data.

You can move the data down and to the right by adjusting the left and top margins. You can also use margin settings to adjust the text to the page even if a template is not used.

The default offset is 0.0 inches. For example, to offset from the top or left margin by 1½ inches, you would enter the value 1.5.

To set the top or left margin, enter the desired value in inches in the appropriate field.

See also “Online template alignment” on page 141.

Characters/Inch
The following table explains the Characters/inch field:

<table>
<thead>
<tr>
<th>Font</th>
<th>Characters/Inch Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>This field is blank since the characters-per-inch varies depending on your data.</td>
</tr>
<tr>
<td>Gothic</td>
<td>This field displays the characters-per-inch, but you cannot change the value.</td>
</tr>
<tr>
<td>Courier/Japanese</td>
<td>You can change the characters-per-inch setting to range from 8.33 to 20.</td>
</tr>
<tr>
<td></td>
<td>To change characters per inch for the Courier or Japanese font, click the down arrow next to the Characters/inch field. Select the setting of your choice.</td>
</tr>
</tbody>
</table>
Style

Currently, COLD offers only the Medium Roman style.

Save the Report Format file

After completing the Report Format file, you must save it. COLD stores the Report Format file in the following directory:

/fnsw/local/cold/formats

To save the Report Format file, select Save from the File menu. The File menu also offers the Save As command that you can use to save the Report Format file with a new name, keeping the original intact.

Delete the Report Format file

The following steps explain how to remove a Report Format from COLD's list of available Report Format files.

1. To display the Define Report Format window, click the Define Report Format button on COLD's Main Menu.

2. Click the List button next to the Report Format Name field. COLD displays the Selection Box containing a list of all Report Format files available on this system.

3. Select the desired Report Format file from the list.

4. From the File menu, select Delete.
Define import job

Before you begin the procedures in this section, collect the data listed in “How to begin” on page 31. You might also want to read the section, “COLD formatting during data processing” on page 173.

The import job file contains the information that COLD requires to process specific data. For example, if you are running a “Nov1998” payroll job, it might contain Report Formats for extracting tax withholding, vacation, and payroll deduction information.

The import job file is stored as a text file in the following directory:

/fns/w/local/cold/jobs

Create the import job file

From the COLD Main Menu, select Define Import Job to display the Define Import Job window. Enter import job information in this window as indicated in the following paragraphs.
Preparing for an import job

Define import job

To specify a job name:

1. To display a Selection Box listing import job files currently on your system or to name a new import job, click the List button next to the Job name field.
Preparing for an import job
Define import job

2 In the Selection Box, select a name or enter a new name.

Use standard file naming conventions. The maximum field length is 14 characters.

3 Click the OK button. COLD returns you to the Define Import Job window.

Job description

If you are creating a new import job file, enter a job description that is meaningful to you in the Description field. The maximum field length is 30 characters.

Fixed-length line

COLD supports fixed-length and variable-length lines (records). If you choose Fixed-Length Line, all the characters on a line are committed.

Characters per line

In the Characters Per Line field, enter the number of characters per line of data, including the channel control character. This is a required field. The maximum value is 256.

All pages in an import job must have the same number of characters per line. If the data is on tape, the number of characters per line must be the same as the record size. The number of characters per line includes the channel control character in the first column.
Variable-length line

COLD supports fixed-length and variable-length lines (records). For example, your lines of data might be 250 characters long, but there is no data on most of each line, and you want to commit only the data. In this case, you might want to choose the Variable-Length Line option.

If you select Variable-length Line, you must specify the character or characters that signal the end of the line. You can specify one or two end-of-line (EOL) characters. For example, your data might have a carriage return and a line feed character at the end of each line. If your data has a carriage return only, like the following illustration, then select only one EOL character.
**End-of-line characters**

Since COLD does not define the end-of-line characters other than as “non-printable character,” you need to know the hexadecimal values of your end-of-line characters.

Typically, UNIX files use a line feed character (0x0a), and DOS files use a carriage return (0x0d) and a line feed (0x0a) character. The allowable range of characters is 0x01 to 0xff.

If you don’t know what end-of-line character(s) your data uses, please see your system administrator.

**Specify a channel control file name**

To specify the channel control file for the import job, click the down arrow next to the Channel control file name field and select from the list of files located in /fnsw/local/cold/channel.

**Select a Report Format**

To specify one or more Report Format files for the import job, select a name from the list in the Available Reports field. Click the Add button after each selection. COLD displays the selected Report Formats in the Selected Reports field.

To remove one or more Report Format files for the import job, choose a name from the Selected reports field. Click the Delete button after each selection.
Preparing for an import job

Define import job

**Important**

The program searches each page sequentially for the literal that specifies the Report Format and uses the first match it encounters. If there happens to be an accidental match that applies to the first Report Format you specify, the program applies that Report Format.

The simplest way to avoid this problem is to make sure that your report literals are sufficiently different so that accidental matches do not occur. You need to know which pages contain data matching the specified Report Formats and list the Report Formats in the appropriate order.

**Save the import job file**

After completing the import file, you must save it. COLD stores the import job file in the following directory:

```
/fnsw/local/cold/jobs
```

To save the import job file, select Save from the File menu. The File menu also offers the Save As command that you can use to save the Report Format file with a new name, keeping the original intact.
Delete the import job file

To remove an import job from COLD's list of available import job files:

1. From the COLD Main Menu, click the Define Import Job button to display the Define Import Job window.

2. Click the List button next to the Job name field. COLD displays the Selection Box containing a list of all import job files available on this system.

3. Select the desired import job file from the list.

4. From the File menu, select Delete.
3

Running an import job

This chapter describes the options that are available after you have specified the job parameters discussed in the previous chapter. This chapter includes:

- “Preview documents” on page 134
- “Import documents” on page 145
- “View import log” on page 150
- “Automating COLD” on page 154
- “Batch committal” on page 164
- “Printing job files” on page 165

Preview documents

Use the Preview Documents function to display pages as they would look in an actual import job. This feature is for previewing and verifying only; no documents are committed. The Preview Documents function runs only on the display console.

Attention

Keep in mind that when you are in Preview Documents mode, you are not running an import job. It’s easy to confuse the Preview Documents program with the Import Documents program; they look very similar.
Select a COLD job to preview

1. From the COLD Main Menu, select Preview Documents to display the Preview Document window.

2. Click the List button next to the COLD job name field to display the Selection Box, which lists the import job files that are stored on your system in the directory /fnsw/local/cold/jobs.

3. Select a job and click the OK button. COLD returns you to the Preview Document window and displays the job name and the job description.
4 If you want to preview non-ASCII data, you need to select a translation map so that COLD can translate the data to ASCII format. Click the down arrow next to the Character Set Translation field to display the character translation maps available on your system.

- To map EBCDIC data to the 8859-1 character set, select the ebc dic_8859-1 file.

- To import COLD data formatted with a character set other than EBCDIC or ASCII, you can create your own character set translation map. For instructions on how to do this, see “Define a character translation map” on page 171.

5 Select the input source type. Your input data can be on tape or disk.

- **Disk**—If the input source is a disk file, click the Disk button. Skip to Step 6 on page 137.

- **Tape**—If the input source is a tape, click the Tape button to activate the Tape Service and Volume Identifier fields.

  - **Tape Service**—The tape services are specific to your installation. Tape service identifies the tape density, block size, character set, and label information. Click the down arrow next to the Tape service field to select the desired tape service.
**Important**

COLD does not process more than the first tape of a multi-tape run if subsequent tapes are not labeled.

- **Volume Identifier**—The text in the Volume Identifier field. If you do not specify a volume identifier, the program searches for the file name on the tape currently in the tape drive. For an example of a volume identifier, see “Tape labels” on page 168.

6 In the File Name field, enter the pathname of the file containing the data. If you aren’t sure of the pathname, click the Select button to find the full pathname of the file containing the ASCII data.

For example:

```bash
fnsw/local/cold/data/NNTdata.DAT
```

If you do not specify a file name for data on a tape, the Import program processes all files on the tape.

7 To preview the specified COLD import job, click the OK button.

If there were any problems with the data or job files during the preview attempt, COLD displays information regarding the problems in the Info Message field. You can look at the Import Log file to find the problem. For more information, see “View import log” on page 150.

**Preview and search data**

With the Preview Documents program, you can view input data, output data, and job parameters. You can also search the data.
The table below lists the four dialog boxes that display together and their purpose.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview Input Data</td>
<td>For viewing the raw data. Display only.</td>
</tr>
</tbody>
</table>
| Preview Output Data      | For viewing the data as it appears using the formatting from your specifica-
                          | tions and background templates. This window displays when you select aPREVIEW SEEK method. |
3 Running an import job

Preview documents

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>COLD Preview Job Parameters</td>
<td>Shows the parameters for the job, data, and selected index values. Display only.</td>
</tr>
<tr>
<td>COLD Preview Seek Methods</td>
<td>Controls the various ways to access COLD pages.</td>
</tr>
</tbody>
</table>

**Attention**

You cannot restart a job in Preview Documents mode. COLD creates the checkpoint files that it uses for restarting only during an actual import. COLD creates a log file when you run either the Preview Documents program or the Import program. See “View import log” on page 150 for details.

**Preview seek methods and string location**

In the Preview Seek Methods dialog box, you can determine how the search of COLD pages is done. The following paragraphs explain these methods.

**Single Step**—To step through pages one at a time, select the Single Step button and click OK.

**Run**—To simulate an actual import job, select the Run button and click OK. You can use the Stop button at any time to stop the run process. For example, you might want to use the Stop button if a run is taking too long.

**Go To specific page**—To display a specific page in a document, select the Go To button, enter the document and page numbers, and click OK.
Skip pages—To skip a specified number of pages to see the page you want to preview, select the Skip button. Enter the number of pages you want to skip, and click OK. The Skip feature is useful for accessing random pages across documents.

Search for specified string—To search for a string that you specify, select the Search button, enter a search string, and click OK. The COLD software searches all text pages for the specified string. The search starts from the current page and goes across document boundaries. The search is case-sensitive and finds matches within a line, but not across line boundaries.

You can use the Stop button at any time to stop the search process. For example, if a search is taking too long, you might want to use the Stop button.

When the software finds a match, it updates the Matched String Location section in the COLD Preview Seek Methods dialog box to reflect the line and column of the matched string within the displayed page.

If a match is not found, COLD displays a message after the end of the file is reached, the preview windows (input, output, job parameters, and seek methods) close, and control returns to the Preview Document dialog box. The Info. Message field on the Preview Documents dialog box explains the reason the search was unsuccessful. COLD only identifies the first occurrence of a string per page.

Matched String Location—The Matched String Location display fields show the line and column in the formatted data where a match to the search string was found.
Action buttons—The action buttons listed below are at the bottom of the COLD Preview Seek Methods dialog box.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>After you select a search method and enter the parameters, click the OK button to start the search.</td>
</tr>
<tr>
<td>Stop</td>
<td>To stop the process when in Run, Search, or Skip mode, click the Stop button.</td>
</tr>
<tr>
<td>Help</td>
<td>To access the COLD help system, click the Help button.</td>
</tr>
<tr>
<td>Align</td>
<td>To access the online template alignment feature, select Single Step mode; then click the Align button. See “Online template alignment” on page 141.</td>
</tr>
<tr>
<td>Cancel</td>
<td>To close all the preview dialog boxes, click the Stop button to stop a search if one is running; then click the Cancel button on the COLD Preview Seek Methods dialog box. The Preview Documents dialog box remains open. To close only the COLD Preview Job Parameters dialog box, click the Cancel button on this dialog box. The other dialog boxes remain open.</td>
</tr>
</tbody>
</table>

Online template alignment

You can associate a template with a document when the document report format is specified. With the Preview Documents, Online Template Alignment feature, you can adjust how the document and template align when displayed or printed. The adjusted template can then be committed as a new document.

Attention

If your server platform is HP9000, make sure the Storage Library server has been configured as a Font server for COLD according to the instructions in the FileNet Image Services Upgrade Procedures. This ensures that COLD documents and templates align correctly. Also see FileNet Image Services Installation and Configuration Procedures. To download IBM FileNet documentation from the IBM support page, see “Accessing IBM FileNet documentation” on page 16.
3 Running an import job
Preview documents

See “Define report format” on page 55 for more information about templates.

To adjust template alignment:
This procedure is useful for making minor template alignment adjustments.

1. If you want to page through the data to check alignment, click the Single Step button on the COLD Preview Seek Methods dialog box to select single step mode.

2. Click the Align button to activate the Preview Output Data window. The template is shown in white.
3 Running an import job

Tip

Before you align a template, you might want to record its original document ID number, because each time the template is aligned, it is saved with a new document ID number. So if you don’t record it, you could lose the original document ID. This process ensures that you always have a copy of the template before the change was made. But, if a template is aligned many times, it can be confusing if you don’t have a record of the document ID number.

3 Use any or all of the methods in the following table to align the template:

<table>
<thead>
<tr>
<th>How To…</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the entire template</td>
<td>Click anywhere on the body of the template. This action displays a large cross-shaped pointer, which you use to grab and move the template.</td>
</tr>
<tr>
<td>Change the template’s width</td>
<td>Click anywhere on the right edge of the template. This action displays a small cross-shaped pointer that you can use to grab and drag the right edge of the template to the right or left.</td>
</tr>
<tr>
<td>Change the template’s height</td>
<td>Click anywhere on the bottom edge of the template. This action displays a small cross-shaped pointer with which you can grab and drag the bottom edge of the template up or down.</td>
</tr>
</tbody>
</table>

Attention

Sizing can only be done in one direction at a time; horizontally or vertically.

4 After you complete template alignment, pull down the File menu on the menubar in the Preview Output Data window. The menu options are
Save or Exit. The following table explains what happens when you select Save and when you select Exit:

<table>
<thead>
<tr>
<th>File Menu Options</th>
<th>Results</th>
</tr>
</thead>
</table>
| **Save**          | • Saves changes to the template.  
|                   | • Commits the template as a new document.  
|                   | • Updates the COLD templates file, which maps template names to the template document ID numbers.  
|                   | • Displays the new document ID number for the modified template.  |
| **Exit**          | If the template was changed, selecting Exit displays a popup dialog box. The options in this popup are Save, Discard, and Cancel.  
|                   | If you select Discard in the popup, any changes to the template are lost.  
|                   | If you select Cancel in the popup, changes are not lost. You can continue to adjust the template.  |

5 Click OK to return to the Preview Seek Methods dialog box.

If no changes were made, the Preview Seek Methods dialog box becomes the active window again.

If the template was changed, COLD displays a popup dialog box. The options in this popup are Save, Discard, and Cancel.

- Click Discard to exit without keeping the changes and return to the Preview Seek Methods dialog box. This dialog box has a Cancel button, should you decide not to save the changes. If you click the Cancel button in the Preview Seek Methods dialog box, another pop-up menu displays with the message: “changes will not be saved.” Click the OK button to exit without saving.

- Click Cancel to return to the Preview Output Data window.
Import documents

Use the Import Documents function to start processing the COLD data. This function:

- Reads the data from the hard disk or tape
- Processes the data according to the instructions in the Channel Control and Report Format files
- Inserts the index values in the index database
- Writes the documents to optical disk
- Generates a log file

The program terminates if no data is found to match the report formats specified in the Import Job file.

Start a new import job

Normally, when you start an import job, it's a new set of data. You can also restart an interrupted or canceled import job. If you are starting a new import job, follow the steps under the heading, “To start a new import job:” on page 145. If you are restarting a canceled or interrupted import job, see “Restart an import job” on page 148.

To start a new import job:

The following procedures explain how to start a new import job.

Note If you are importing non-ASCII data, click the down arrow next to the Character Set Translation field to display the character translation...
maps available on your system. For details, see the information on page 136.

1 From the COLD Main Menu, select Import Documents. This displays the Import Document window.

   ![Import Document Window]

2 Click the No button to indicate that this is not a restart.

3 Click the List button next to the COLD Job Name field to display the Selection Box listing import job files that are stored on your system in the /fnsw/local/cold/jobs directory.
3 Running an import job

4 Select a job and click the OK button. COLD returns you to the Import Document window and displays the job name and the job description.

5 Select the input source type. Your input data can be on tape or disk.

- **Disk**—If the import source is a disk file, click the Disk button.

- **Tape**—If the import source is a tape, click the Tape button to activate the Tape service and Volume identifier fields.

  - **Tape Service**—The tape services are specific to your installation. Tape service identifies the tape density, block size, character set, and label information. Click the down arrow next to the Tape service field to select the desired tape service.

  Important

  COLD does not process more than the first tape of a multi-tape run if subsequent tapes are not labeled.

  - **Volume Identifier**—Enter the volume identifier in the Volume identifier field. If you do not specify a volume identifier, the program searches for the file name on the tape currently in the tape drive. For an example of a volume identifier, see “Tape labels” on page 168.

6 Enter the name of the tape file containing the data in the File name field, or click the Select button to select the full pathname of the disk file containing the ASCII data.

   For example:

   /fnsw/local/cold/data/NNTdata.DAT

   If you do not specify a file name for data on a tape, the Import program processes all files on the tape.
Click OK to import the COLD job you specified.

If there were any problems with the data or job files during the import attempt, COLD displays information regarding problems in the Info Message area.

**Restart an import job**

COLD periodically checks its progress during an import run and creates a checkpoint file indicating the last record processed in that job.

When an interruption to the import process occurs, COLD can restart the process by accessing the checkpoint file to determine where the interruption occurred. If the restart job runs to completion, COLD automatically deletes the checkpoint file.

**Important** Restart should only be used if you suspend the job by clicking the cancel button NOT after an abnormal failure such as a power outage or system shutdown. Import job restart after an abnormal failure is not reliable. Indexes could be lost. In the case of an abnormal failure we recommend that you redo the Import Job from the beginning.

The checkpoint file name is in the format ckp.<job_id>, where <job_id> is the unique date-time stamp (mm:dd:hh:mm:ss format) for the job. The import program updates the checkpoint file every time it gets a block of 1,000 document IDs from FileNet Image Services. COLD updates the checkpoint file when a batch is committed.
The following paragraphs explain restart procedures.

**To restart a disk file import job:**

1. From the COLD Main Menu, select Import Documents to display the Import Document window.

2. Click the Yes button to indicate that this is a restart.

3. To display the Selection Box listing checkpoint files, click the down arrow next to the Job ID field. Unless several jobs have been interrupted, there should be only one job listed.
3 Running an import job

View import log

4 Select the file for the job that you want to restart.

5 Click the OK button. COLD returns you to the Import Document window and displays the import job name, its description, the input source, and the data file name.

6 To restart the job, click the OK button in the Import Document window.

To restart a multi-tape import job:
Remount the tape that was running when the job was suspended and then follow the steps outlined under the heading “To restart a disk file import job:” on page 149.

View import log

While running an import job, COLD generates a Log file containing information about the session, such as start time, stop time, the ID numbers of the first and last documents committed, and number of pages processed. You can view this log from any workstation on the system.

To view an import log:

1 From the COLD Main Menu, click View Import Log to display the COLD Import Log window. COLD displays the log for the most recent job.
3 Running an import job

To view another log, click the down arrow next to the Log file name field.

Click on a log to select it. COLD returns you to the COLD Import Log window and displays the log information.
The Import Log fields

The following table describes the fields in the COLD Import Log dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log File Name</td>
<td>Log files are named in the format: Log.&lt;mmddhhmmss&gt; where &lt;mmddhhmmss&gt; is the date and time the job started. The log files are stored in the directory /fnsw/local/logs/cold for UNIX Servers or \fnsw_loc\logs\cold\ for Windows Servers.</td>
</tr>
<tr>
<td>Job Name</td>
<td>This is the name that you assigned when you defined the import job.</td>
</tr>
<tr>
<td>Description</td>
<td>This is the job name description that you assigned when you defined the import job.</td>
</tr>
<tr>
<td>Operator</td>
<td>This field displays the user login name, domain, and organization.</td>
</tr>
<tr>
<td>Source Input</td>
<td>This is the pathname of the data’s location.</td>
</tr>
<tr>
<td>Start, Stop, Elapsed Time</td>
<td>These fields display the date and time (to the second) that the import job started, stopped, and how long the import job took. (How the date displays is determined by the machine language and is always hours, minutes, and seconds.)</td>
</tr>
<tr>
<td>Total Warnings</td>
<td>If any errors occur during an import job, COLD indicates the number of warning messages in this field and displays a View button next to the number. Click the View button to see the list of errors in the error log. For more information on the error log, see “Error Log” on page 153.</td>
</tr>
<tr>
<td>Document Classes Processed</td>
<td>This is a list of all the document classes that you assigned to the report format(s) used in the import job.</td>
</tr>
<tr>
<td>First/Last Doc. ID Committed</td>
<td>The First Doc. ID Committed field indicates the lowest document ID number committed for the session. The Last Doc. ID Committed field indicates the highest document ID number committed for the session. These fields do not necessarily indicate that all document numbers in that range are committed.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**Blank Fields** If you are looking at a COLD Import Log for a Preview job, the fields in the committed/processed section are blank, and the Completion Status field indicates “Job completed.”

| No. of Pages Processed/Committed | These two fields display the number of pages processed and the number of pages committed during the import job. |
| No. of Documents Processed/Committed | These two fields display the number of documents processed and the number of documents committed during the import job. |
| Completion Status | This is the status of the import job. The status is either “Job completed” or “Job was cancelled.”

An error message could be displayed in this field as well. In some instances, the entire message might not display because of the length of the message. In that case, a partial message is displayed ending with an ellipsis (...). See the error log for the complete message text.

### Error Log

The error log contains the following information regarding an import job:

- Reel Number (if tape)
- Block Number
- Offset within the Block
- Document ID
- Page Number
- Error Tuple and Message Text

To view the Error log, click on the View button next to the Total Warnings field in the COLD Import Log dialog box.
Automating COLD

Automated or unattended operation of COLD could have benefits to you or your installation. Because COLD processing can slow down other activities on your FileNet Image Services server, and interfere with other activities on the system, you might want to process COLD data at a time when system activity is low. To run COLD unattended, use the 3770 daemon program.

The 3770 program can be left running continuously for regular processing of data files. However, unless you have configured your system to automatically start up the daemon along with the FileNet software, you must restart the daemon every time you reboot the FileNet Image Services server. For information on configuring your system to automatically start the daemon, see “Start the 3770 daemon automatically” on page 162. For information on manually starting the daemon, see “Start the 3770 daemon manually” on page 163.

You could transfer files every night from your mainframe to the FileNet Image Services server for input to COLD via ftp, RJE/SNA services, rcp, etc. You could then have the 3770 daemon import the files to COLD.

**Attention**

If importing data to COLD by way of RJE/SNA, RJE typically adds the control characters “JCL,” or other extraneous characters. You should remove these characters from the data. COLD processes these characters as data.

Most of the procedures described in this section require that the user who wants to make the changes be a member of fnadmin or fnop, or log on using fnlogon.
Overview of 3770 daemon processing

The daemon searches the FileNet Image Services server for input files with a prefix of IN_, CO_, or TX_. These prefixes indicate that a file is there for COLD to process. COLD processes files on a “first in, first out” basis, including multiple files submitted for the same job.

When the 3770 daemon program finds an input file, it finds the name of the COLD import job file by reading the characters after the prefix and then locates the import job file in the /fnsw/local/tmp/3770 directory. You create the import job file in COLD’s Define Import Job program. See Chapter 2, “Preparing for an import job,” on page 30. The import job file specifies the record length, the channel control file, characters per line, and the report formats to apply to the data.

After the 3770 daemon program matches a data file to an import job file, it starts COLD. COLD then does the following:

- Reads the data file.
- Processes the data according to the instructions in the Channel Control and Report Format files.
- Inserts the index values in the index database.
- Writes the documents to optical disk.
- Deletes the file, if it was processed successfully. If an error occurred during processing, COLD renames the file “error_<originalfilename>” and stores it in the same place as the original file (/fnsw/local/tmp/3770). If you prefer, you can configure COLD to save the data file instead of deleting it.
Generates a log file, which COLD stores in the /fnsw/local/logs/cold directory. For more information about log files, refer to "View import log" on page 150.

File-naming conventions for automatic processing

The 3770 daemon searches the /fnsw/local/tmp/3770 directory for files with specific prefixes. This section explains the conventions you should use when naming COLD files. The following list describes how to name the files that you transfer to the FileNet Image Services server:

* IN_aaa…a[.suffix]
* CO_aaa…a[.suffix]
* TX_aaa…a[.suffix]

where:

<table>
<thead>
<tr>
<th>IN_</th>
<th>Indicates that the data is in EBCDIC format. COLD automatically converts EBCDIC format to ASCII.</th>
</tr>
</thead>
<tbody>
<tr>
<td>CO_</td>
<td>Indicates that the data is in ASCII format.</td>
</tr>
<tr>
<td>TX_</td>
<td>Indicates that the data uses a user-defined character translation table.</td>
</tr>
<tr>
<td>aaa…a</td>
<td>The name of a COLD import job file located in the /fnsw/local/cold/jobs directory</td>
</tr>
<tr>
<td>.suffix</td>
<td>An optional string to identify multiple data files for the same job. For example, &quot;.1&quot; could identify the first file in the sequence, &quot;.2&quot; the second, etc. The actual sequence of processing is determined by the order in which files are submitted to the directory rather than by the alphanumeric sequence of the suffixes. You can use the filename suffix to submit more than one data file for the same job.</td>
</tr>
</tbody>
</table>
The COLD 3770 command and options

The command and its required accompanying options that you enter at the system prompt to start the COLD 3770 daemon is:

```
cold_3770 [<option> <info>]
```

Command line options control the function of the daemon. Some options can be used alone; some must be used with other options entered on the command line.

The table below shows the options and their functions.

<table>
<thead>
<tr>
<th>Options</th>
<th>Function</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>–d</td>
<td>Defines the data file directory</td>
<td>Can be used alone or with other options.</td>
</tr>
<tr>
<td>–m</td>
<td>Defines the marker file directory</td>
<td>Must be used with –d. Cannot be used alone.</td>
</tr>
<tr>
<td></td>
<td>(For a definition of marker file, see “Define marker file directory (–m)” on page 159.)</td>
<td></td>
</tr>
<tr>
<td>–s</td>
<td>Saves the data files</td>
<td>Must be used with –m. Cannot be used alone.</td>
</tr>
<tr>
<td>–t</td>
<td>Defines the character translation table</td>
<td>Can be used alone or with other options.</td>
</tr>
<tr>
<td>–p</td>
<td>Defines polling frequency</td>
<td>Can be used alone or with other options.</td>
</tr>
</tbody>
</table>
Syntax

cold_3770 [[–d <data_dir>] [–m <marker_dir> ] [–s]]
[–t <char_trans_file_name>] [–p <secs>] [–h]

Define directory options (–d, –m, –s)

The options to define directories are –d, –m, and –s. (For definitions of these options, see the table on page 157.)

Define data file directory (–d)

The default data file directory is /fnsw/local/tmp/3770. If you want to use this directory, you do not need to use the –d option or define a directory.

To define another data directory, enter the command below at the system prompt:

cold_3770 –d <data directory pathname>

Command line example:

cold_3770 –d /fnsw/local/tmp/3770/data
You can use the –d option alone, or with the –m option, or with the –m and –s options. If you use the –m and –s options on the same command line, you must also use the –d option. Files in the data file directory are the actual data files that COLD will process.

**Define marker file directory (–m)**

*Important*

There is a danger in using the default for the marker file directory because the default marker file directory and the data file directory are the same, /fnsw/local/tmp/3770. When the data and marker directories are the same, processing can begin on the data files before the data is completely transferred. This premature processing can cause files to be processed incorrectly or even deleted.

The existence of a file in the marker directory indicates to COLD that the corresponding file in the data directory is ready to be processed. The files here are just markers. Data files must be completely transferred into the data directory before the marker file is created in the marker directory.

The –m option defines the marker file directory. It must be used with the –d (define data directory) option. You can use the –m option with other options but it cannot be used alone.

To specify the marker directory, enter the command below at the system prompt.

```
cold_3770 –d <data_dir> –m <marker_dir>
```

Command line example:

```
cold_3770 –d /fnsw/local/tmp/3770/data –m /fnsw/local/tmp/3770/marker
```
Save data files (–s)

The –s option saves the data files after successful committal when the data directory and the marker directory are specified as different directories. The default is to delete the files. The –s option is used in addition to the –d (define data directory) and the –m (define marker directory) options. The –s option cannot be used alone.

To save the data files when data and marker directories are different, enter the command below at the system prompt.

```
cold_3770 –d <data_dir> –m <marker_dir> –s
```

Command line example:

```
cold_3770 –d /fnsw/local/tmp/3770/data –m /fnsw/local/tmp/3770/marker –s
```

Define translation table (–t)

The –t option specifies the user-defined character translation table to be used for processing the COLD data files prefixed with TX_. The –t option can be used on the command line alone or with other options. When using the –t option, you don’t need to specify the translation file’s full pathname, just the file name.

The user defined character translation table must reside in the directory /fnsw/local/nltmaps.

The –t option is not required on the command line.

**Important** Do not use this option if the translation file that you want to use has not already been created.
To define a translation table for UNIX platforms:
Enter the command below at the system prompt:

    nohup /fnsw/bin/cold_3770 –d <directory> –t <translat’n file> &

Command line example:

    nohup /fnsw/bin/cold_3770 –d /fnsw/tmp –t hextohex &

To define a translation table for Windows Server platforms:
Enter the command below at the system prompt:

    \fnsw\bin\cold_3770 –d <directory> –t <translation file>

Command line example:

    \fnsw\bin\cold_3770 –d \fnsw\tmp –t hextohex

**Define polling frequency (–p)**

The –p option sets the daemon’s polling frequency. The –p option can be used on the command line alone or with other options.

The 3770 daemon’s default polling frequency is once every 60 seconds. If this frequency is adequate, you don’t need to specify the –p option. To increase or decrease the frequency, enter the –p option followed by the number of seconds you want between polling cycles.

If you specify fewer than 60 seconds as a polling frequency, the daemon polls more frequently and can increase throughput. If you specify more than 60 seconds as a polling frequency, the daemon polls less frequently and can reduce throughput. The range commonly used...
is from 15 to 7200, although the possible range is much greater (0 to more than a billion).

When you enter zero, the daemon runs once and then exits.

To define the daemon's polling frequency, enter the command below at the system prompt:

```
cold_3770 -p <seconds>
```

Command line example:

```
cold_3770 -p 15
```

**Display usage report (–h)**

The –h option displays the syntax for the command. The –h option can be used on the command line alone or with other options.

To display a usage report for the cold_3770 command, enter the following at the system prompt:

```
cold_3770 -h
```

**Start the 3770 daemon automatically**

If you want the cold_3770 daemon to start automatically every time you start the FileNet Image Services software, add the commands shown below to the appropriate file. To run the commands below, you must be a member of fnadmin or fnop, or log on using fnlogon.

**UNIX**

To start the 3770 daemon automatically on UNIX-based platforms:

1. Create an executable file named:
Running an import job

Automating COLD

May 2011 FileNet Image Services COLD Handbook, Version 4.2

/start

2 Enter the commands below in the file you created:

```bash
echo "Starting cold_3770 daemon" >> $OFILE
/fnsw/bin/sys_log "Starting cold_3770 Daemon"
nohup /fnsw/bin/cold_3770 <options> > /dev/null &
echo "Initialization of cold_3770 Daemon complete." >> $OFILE
```

To start the 3770 daemon automatically on Windows Server-based platforms:

1 Create a batch file named:

```
\fnsw_loc\sd\ims_start.bat
```

2 Enter the commands below in the file you created:

```bash
echo "Starting cold_3770 daemon"
<drive>:\fnsw\bin\sys_log "Starting cold_3770 Daemon"
start /b <drive>:\fnsw\bin\cold_3770 <options>
echo "Initialization of cold_3770 Daemon complete."
```

Start the 3770 daemon manually

If you want to run the 3770 daemon manually, enter the commands explained in the following procedures at the system prompt. To run the commands, you must be a member of fnadmin or fnop, or log on using fnlogon.
To start the 3770 daemon manually on UNIX-based platforms:
At a terminal attached to the server, enter the following at the command line:

```
nohup /fnsw/bin/cold_3770 <options> &
```

To start the 3770 daemon manually on Windows Server-based platforms.
At a terminal attached to the server, enter the following at the command line:

```
start/b <drive>:\fnsw\bin\cold_3770 <options>
```

Stop the 3770 daemon

To stop the 3770 daemon on UNIX-based platforms, you must use the kill command.

To stop the 3770 daemon on Windows Server-based platforms, you must use the End Task option on the Task List menu.

**Important** Stopping the 3770 daemon will cause unrecoverable interruption to a running COLD process. Before killing a 3770 daemon, please make sure all the data in the data directory has been processed and that there are no pending processes.

**Batch committal**
The import program commits the documents to a batch indicated by the job name. Each document has a header page and a maximum of 1,000 pages per document. COLD uses fast batch committal, which
means that batches are committed directly to optical disk without temporarily storing the images in cache. The Query Match Report can display COLD documents as soon as committal is complete.

This type of committal does not let you retrieve and display document images contained in a batch until that batch is committed to optical disk. The batch committal program provides for shared access to the optical disk.

COLD inserts index values through FileNet Image Services Document Services in the same way as other committed documents.

COLD committals are write requests, which are in the middle of the priority scale. See the table below for examples of job request priorities. The shaded row in the table indicates COLD’s default priority.

<table>
<thead>
<tr>
<th>Priority</th>
<th>Definition</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>High Priority Read</td>
<td>A retrieval request for a document on optical media (top priority).</td>
</tr>
<tr>
<td>2</td>
<td>Medium Priority Read</td>
<td>The next document in a Query Match Report.</td>
</tr>
<tr>
<td>3</td>
<td>Write Requests</td>
<td>A document committal, including COLD.</td>
</tr>
<tr>
<td>4</td>
<td>Low Priority Read</td>
<td>A prefetch request.</td>
</tr>
<tr>
<td>5</td>
<td>Background Job request</td>
<td>An import or disk copy operation (lowest priority).</td>
</tr>
</tbody>
</table>

Printing job files

It can be helpful to have a hard-copy record of the various components that go into running an import job in case you should ever have to recreate them. For a written record, you can use a copy of the Session Checklist on page 189, or you can print the ASCII COLD job files on a printer for a hardcopy record. COLD job files include:
Background template
Channel control
Report format
Import job
Import log

From the File menu in any of the above definition windows, select the Print command.

**Job file example**

The following is an example of how the FN_DEFAULT channel control file looks when printed:

<table>
<thead>
<tr>
<th>Line</th>
<th>Spacing</th>
<th>Vertical Tab</th>
<th>Paging</th>
<th>Ignore</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x20</td>
<td>1</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>0x30</td>
<td>2</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>0x2d</td>
<td>3</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>0x2b</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
<td>1</td>
</tr>
<tr>
<td>0x26</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
<td>1</td>
</tr>
<tr>
<td>0x31</td>
<td>NONE</td>
<td>NONE</td>
<td>1</td>
<td>NONE</td>
</tr>
</tbody>
</table>
Appendix A – COLD data formats

This appendix contains information on the following topics:

- Input and output data formats
- Preprocessing and postprocessing
- Minimum and maximum values

Input data formats

COLD accepts text data from tape or disk in ASCII, EBCDIC, or other formats, depending on the source. If the data is in any format other than ASCII, COLD translates it to ASCII before writing it to disk. Because non-ASCII files must go through this translation, they take slightly longer to process than ASCII files.

Attention

To prepare for an import session, detailed information is required for both disk and tape files. Use a checklist to make sure you gather all the information needed. See the checklist supplied on page 189.

Disk files as source

If the source of the input data is a disk file, have your customer service representative configure your system with a file system large enough to contain your files. You might want to create a file system partition called “miscellaneous” and mount it as /cold; then load all imported data files into this directory.
Tapes as source

To prepare for a COLD session, you need explicit information about the data on the tape. The following paragraphs can help to find the needed information, or you can request it from the company or department that writes the data.

Tape labels

The illustration below specifies where you can find the reel number, block size, and record size information on the tape:

```
VOL1011009
HDR1ET.STMTS.G0079V0001393200080001007900 88247 000000000000IBM OS/VS 379
HDR2F9842001331 IDPFLNET/FILENET B 67401
```

Command examples for accessing tape information are as follows:

<table>
<thead>
<tr>
<th>Command</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the tape label.</td>
<td>dd if=/dev/1/rmt0 bs=80 conv=ascii</td>
</tr>
<tr>
<td>Copy the tape label to a file.</td>
<td>dd if=/dev/1/rmt0 of=/tmp/tapelabel bs=80 conv=ascii</td>
</tr>
<tr>
<td>Copy the label from a file to a new tape.</td>
<td>dd if=/tmp/tapelabel of=/dev/1/rmt16 bs=80</td>
</tr>
<tr>
<td>Copy the data on a tape to a file.</td>
<td>dd if=/dev/1/rmt0 of=/tmp/tapedata bs=x</td>
</tr>
<tr>
<td>Copy COLD data from a file to a new tape, where x is the block size:</td>
<td>dd if=/tmp/tapedata of=/dev/1/rmt0 bs=x</td>
</tr>
</tbody>
</table>
See the *System Administrator's Handbook* for more information about the `dd` command and its options.

**Labeled tapes**

An import job can span several tape reels, but all the tapes must be labeled.

Labels and data must be written on the tape in the following format:

```
BOT  VOL  HDR  TM  DATA  TM  EOV  TM  TM
```

**Important** COLD processes the first tape in a multi-tape import job but, does not process the remaining tapes if they are unlabeled. COLD can process unlabeled tapes, but only one at a time.
These format elements are described in the table below.

<table>
<thead>
<tr>
<th>Format Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOT Beginning of Tape</td>
<td>The program starts reading data after the BOT marker and continues to read data until it encounters an end-of-volume (EOV) label or an end-of-file label (EOF).</td>
</tr>
<tr>
<td>VOL Volume Label</td>
<td>Each tape in a multi-volume set has a volume label indicating the serial number.</td>
</tr>
<tr>
<td>HDR Header Label</td>
<td>The header label contains the tape number and a description of the data on the tape. The tape number links the tapes in a multi-volume set. The description of the data includes the format, the block length, and the record length (line length).</td>
</tr>
<tr>
<td>TM Tape Mark</td>
<td>A single tape mark precedes and follows the data. A double tape mark signals the physical end of the tape.</td>
</tr>
<tr>
<td>DATA Data Blocks</td>
<td>Each data record begins with a printer control character (channel control character) and corresponds to a line of text. The program starts a new page when it has processed the maximum number of lines in a page, or when the printer control character is a 1, whichever occurs first.</td>
</tr>
<tr>
<td>EOF End of File Label</td>
<td>When the program encounters an end-of-file label, it terminates.</td>
</tr>
<tr>
<td>EOV End of Volume Label</td>
<td>When the program encounters an end-of-volume label, it prompts you for the next numbered tape.</td>
</tr>
</tbody>
</table>

**Unlabeled tapes**

An unlabeled tape has the following format:

```
BOT DATA TM TM
```

The program expects data following the beginning of tape marker (BOT). It will continue processing data until it detects a double tape mark (TM TM) indicating the physical end of the tape.
Importing EBCDIC and other character sets to COLD

You can import EBCDIC data to COLD by specifying that COLD translate this data to ASCII format. COLD provides the ebcdic_8859-1 character translation map for this purpose.

You select the translation map from within COLD’s Import Document function. For details on how to select a translation map. See “Import documents” on page 145.

Define a character translation map

You might also need to import data to COLD that is in a format other than EBCDIC. To do this, you must create your own character translation map in the following way:

- Create an ASCII file that maps the source character set to the destination character set.
- Use the FileNet NLT_build_maps command to convert this ASCII file to binary format.
- From within COLD’s Import Document function, select the binary character translation map file.

The following paragraphs describe this procedure.

Create an ASCII file

Create an ASCII file that maps the source character set to the destination character set. This ASCII file consists of 256 records. Each record contains two columns. The left column contains the source character’s hexadecimal value. The right column contains the destination character’s hexadecimal value.
For example, the following record maps the character “A” from the EBCDIC character set to the ISO8859-1 character set.

<table>
<thead>
<tr>
<th>Source Character</th>
<th>EBCDIC</th>
<th>ISO8859-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capital letter A</td>
<td>0xc1</td>
<td>0x41</td>
</tr>
</tbody>
</table>

COLD ignores any characters following the second column. Use this area to enter descriptions of the character. Any record beginning with a # or space is a comment line.

Store the ASCII file in the /fnsw/local/nltmaps directory.

**Convert the ASCII file to binary format**

Use the NLT_build_maps command to convert the ASCII file to binary format. The usage of NLT_build_maps is:

```
NLT_build_maps {–c | –v} –s<source_map> –n<normal_map> –i<inverse_map>
```

<table>
<thead>
<tr>
<th>where:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>–c</td>
<td>Specifies that the translation map be created using &lt;source_map&gt;.</td>
</tr>
<tr>
<td>–v</td>
<td>Specifies that the binary translation map be verified as the correct output of the source. Use this parameter if you are noticing translation problems and want to check the validity of the binary file.</td>
</tr>
<tr>
<td>–s&lt;source_map&gt;</td>
<td>Represents the name of the ASCII source translation file. Required.</td>
</tr>
<tr>
<td>–n&lt;normal_map&gt;</td>
<td>Represents the name of the binary translation map to be created or verified in the local directory using &lt;source_map&gt;.</td>
</tr>
<tr>
<td>–i&lt;inverse_map&gt;</td>
<td>Represents the name of an inverse translation map to be created or verified in the local directory using &lt;source_map&gt;.</td>
</tr>
</tbody>
</table>
Make sure that you create the binary translation maps with a name that describes the nature and direction of the mapping. For example, the ebcdic_8859-1 file indicates that the map is from EBCDIC to the ISO8859-1 character-set.

After converting your ASCII character translation map to binary format, it is available for selection from within COLD’s Import Document function. For details on this procedure, See “Import documents” on page 145.

COLD software automatically converts binary format job files from previous versions of COLD to ASCII format the first time you use Preview Documents, Import Documents, and cold_3770.

**COLD formatting during data processing**

At various times, you specify where certain information resides in your data. For example, you specify on which line or page to get:

- Indexing information
- Report ID literal
- Start-of-Document indicators
- Filtering information
- Table of Contents key
Before COLD applies any formatting to the data; it is raw data. After COLD applies the channel control character formatting, as described in “Format data using channel control characters” on page 45, the data is now at least partially formatted, and the line and page numbers might be different from those in the raw data. This is preprocessed data. During the import session, COLD applies other formatting that you have specified in the report format file.

So, which line and page numbers do you use when you specify that COLD should look on certain lines or pages for data, those for the formatted or the unformatted data?

This illustration helps to answer the question.

As the graphic illustrates, COLD finds start-of-document indicators, report ID literals, and applies channel control character formatting on the raw, unformatted data.
Preprocessing

When defining a channel control file and a report format, you specify the locations of the following data items relative to the raw data:

- The start-of-document indicator(s) indicates where a new variable-length document begins.
- The channel control characters tell COLD to ignore a line or specify the spacing for a line.
- The report ID literal identifies the report format definition file.

Postprocessing

When defining a report format, you specify the locations of the following data items relative to the preprocessed data:

- Lines and pages to be filtered out.
- Table of contents field.
- Index values.

If a channel control character on page 14 indicates that COLD should ignore that page, the data on page 15 becomes page 14 in the preprocessed data. Similarly, a channel control character that causes lines to be double-spaced could cause data that was on line 36 to be positioned on line 72 in the preprocessed data.

When you indicate the locations of index values, table of contents keys, report IDs, etc., be sure to make any necessary allowances and adjustments for the formatting done by the channel control file.
Start-of-document indicators are the only Report ID parameters where COLD searches the raw import data. Raw here means before channel control characters are applied. However, start-of-document indicators are applied after page filtering and might not generate expected documents. If an and/or start of document indicator appears on a filtered page, a new document is not triggered, and the page immediately following starts a new document only if the start-of-document indicators are different from the last unfiltered page.

**Output data formats**

COLD writes data to optical disk as ASCII text; it does not convert the data to image format. This means that COLD's storage requirements are much smaller than for images processed by other FileNet software. For example, a typical text page is approximately 2KB, but an average image is 75KB. COLD saves more space by automatically compressing blank lines in a text file. COLD saves even more space if you select the Enable Page Compression feature from the Define Report Format window.

The FileNet system stores background templates separately from the COLD data. The COLD data references the background templates so they display and print together.
Appendix B – Disk space management

During processing, COLD generates a number of files that are either created and named by the user or by the software. You should periodically check your hard disk to make sure that obsolete COLD files are not taking up space unnecessarily.

Managing disk space

The table below describes the files created by COLD and how you can remove them, except for the FN_DEFAULT channel control file.

<table>
<thead>
<tr>
<th>File</th>
<th>File Name</th>
<th>Directory — How to Delete It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Template</td>
<td>User-defined</td>
<td>/fnsw/local/cold/templates From the command line or within COLD (Define Background Templates).</td>
</tr>
<tr>
<td>Channel Control</td>
<td>FN_DEFAULT or</td>
<td>/fnsw/local/cold/channel Do not delete the channel control file, FN_DEFAULT. This file is</td>
</tr>
<tr>
<td></td>
<td>User-defined</td>
<td>the basis for other channel control files.</td>
</tr>
<tr>
<td>Report Format</td>
<td>User-defined</td>
<td>/fnsw/local/cold/formats From the command line or within COLD (Define Report Format).</td>
</tr>
<tr>
<td>COLD Data</td>
<td>User-defined</td>
<td>User-defined directory From the command line. COLD data files processed by the cold_3770</td>
</tr>
<tr>
<td></td>
<td></td>
<td>program are deleted automatically.</td>
</tr>
<tr>
<td>Import Job</td>
<td>User-defined</td>
<td>/fnsw/local/cold/jobs From the command line or within COLD (Define Import Job).</td>
</tr>
</tbody>
</table>
### Appendix B – Disk space management

Managing disk space

<table>
<thead>
<tr>
<th>File</th>
<th>File Name</th>
<th>Directory — How to Delete It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Log</td>
<td>log.jobid, where jobid is the date-time stamp for the start of the job.</td>
<td>/fnsw/local/logs/cold After you view this file, COLD asks you if you want to delete it. Can also be deleted from the command line.</td>
</tr>
<tr>
<td>Checkpoint</td>
<td>ckp.jobid, where jobid is the date-time stamp for the start of the job.</td>
<td>/fnsw/local/logs/cold Automatically deleted by COLD when an import job successfully completes; otherwise, from the command line. <strong>Do not delete a checkpoint file unless you are sure that it will not be needed to resume processing an interrupted job.</strong></td>
</tr>
</tbody>
</table>
Appendix C – Performance factors and restrictions

This appendix discusses some of the aspects of the COLD application that can impact performance, and other considerations that might restrict production.

**Performance factors**

COLD’s performance varies depending on a number of factors including (but not limited to) the following:

**Input source (disk or tape)**

COLD processes files from disk faster than those from tape.

**Space required in page cache**

In order to run, COLD needs 20MB of contiguous disk space in page cache. To process variable-page documents with variable-length lines, the minimum grows to 90MB.

**System activity**

Any activity on your system can affect COLD’s performance and cause documents to process more slowly.
Appendix C – Performance factors and restrictions

Performance factors

Type of server

COLD performs best when running on a storage library server. You can also run COLD on an Index server, or on a Combined Storage Library/Index server.

For optimum performance in a Dual server environment, run COLD on the storage library server.

Document length

Long documents process faster than the same number of pages broken into short documents. For example, COLD processes a single 100-page document almost four times faster than it processes 100 one-page documents.

Number of index values per document

The greater the number of index values, the slower the process.

Source of index values (constants or variables)

COLD must extract variable index values from the data, searching for them in specified locations. For this reason, variable index values can increase processing time.

Amount of data per page

The greater the amount of data per page, the slower the process.
Variable-length compared to fixed-length documents

COLD processes variable-length documents more slowly than fixed-length documents regardless of the number of pages per document. This is because the software must search each page to determine when to start a new document.

On the other hand, variable-length documents are limited to one document class, so they might process faster than fixed-length documents using multiple document classes.

Variable-length compared to fixed-length records

As with variable-length and fixed-length documents, the software must search each line to find an end-of-line sequence.

ASCII compared to non-ASCII data

Because COLD must convert non-ASCII data to ASCII, the conversion process increases process time for non-ASCII data.

Table of contents processing

Because COLD must search the data for the table of contents key, table of contents preparation slows down COLD processing.

Filtering

Page and line filtering can take time if COLD must search the data for the search literals. However, filtered data requires less space on optical disk.
Keyword search

Because COLD must search every page if a page number is not specified, and every line if a line number is not specified, a keyword search for index values can impact performance.

Restrictions and considerations

Some restrictions and considerations for using COLD are as follows:

Printer and scanner distortion

Some printers and scanners might distort an image slightly. To align COLD data on a background template, you must adjust the margins and font size. You might want to test the alignment of a template with your COLD data by printing it. (The laser printer does not alter the size of the printed image.)

Data prints outside template boundary

A local printer or FileNet printer can produce printed output with the data printed outside of the template boundary. Yet, the document appears normal when displayed. This can occur when using certain releases of WorkForce Desktop to print COLD documents.

Restart an interrupted job

You must restart an interrupted import job by using the COLD import process.

You cannot restart a Preview Documents process.
Appendix C – Performance factors and restrictions
Restrictions and considerations

Maximum characters per line
Each record yields one line of text. A line can contain a maximum of 256 characters.

Scroll to see all data
If the lines of data are too long to fit in a display window, you can scroll the screen to see all of the characters. If a line is too long to fit on one line, the printing software wraps the text to the next line.
Appendix D – Table of contents examples

This appendix contains four examples of how a table of contents might display and print using the Gothic fonts.

<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alabama</td>
<td>2</td>
</tr>
<tr>
<td>Alaska</td>
<td>3</td>
</tr>
<tr>
<td>Arizona</td>
<td>4</td>
</tr>
<tr>
<td>Arkansas</td>
<td>5</td>
</tr>
<tr>
<td>California</td>
<td>6</td>
</tr>
<tr>
<td>Colorado</td>
<td>7</td>
</tr>
<tr>
<td>Connecticut</td>
<td>8</td>
</tr>
<tr>
<td>Delaware</td>
<td>9</td>
</tr>
<tr>
<td>Florida</td>
<td>10</td>
</tr>
<tr>
<td>Georgia</td>
<td>11</td>
</tr>
<tr>
<td>Hawaii</td>
<td>12</td>
</tr>
<tr>
<td>Idaho</td>
<td>13</td>
</tr>
<tr>
<td>Illinois</td>
<td>14</td>
</tr>
<tr>
<td>Indiana</td>
<td>15</td>
</tr>
<tr>
<td>Iowa</td>
<td>16</td>
</tr>
<tr>
<td>Kansas</td>
<td>17</td>
</tr>
<tr>
<td>Kentucky</td>
<td>18</td>
</tr>
<tr>
<td>Louisiana</td>
<td>19</td>
</tr>
<tr>
<td>Maine</td>
<td>20</td>
</tr>
<tr>
<td>Maryland</td>
<td>21</td>
</tr>
<tr>
<td>Massachusetts</td>
<td></td>
</tr>
<tr>
<td>Michigan</td>
<td></td>
</tr>
<tr>
<td>Minnesota</td>
<td></td>
</tr>
<tr>
<td>Mississippi</td>
<td></td>
</tr>
<tr>
<td>Missouri</td>
<td></td>
</tr>
</tbody>
</table>

Gothic 12
6.25 lines per inch (default)
with template
Appendix D – Table of contents examples

<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>555-1111</td>
<td>2</td>
</tr>
<tr>
<td>555-1122</td>
<td>3</td>
</tr>
<tr>
<td>555-1136</td>
<td>4</td>
</tr>
<tr>
<td>555-1150</td>
<td>5</td>
</tr>
<tr>
<td>555-1163</td>
<td>6</td>
</tr>
<tr>
<td>555-1177</td>
<td>7</td>
</tr>
<tr>
<td>555-1182</td>
<td>8</td>
</tr>
<tr>
<td>555-1190</td>
<td>9</td>
</tr>
<tr>
<td>555-1219</td>
<td>10</td>
</tr>
<tr>
<td>555-1247</td>
<td>11</td>
</tr>
<tr>
<td>555-1330</td>
<td>12</td>
</tr>
<tr>
<td>555-1456</td>
<td>13</td>
</tr>
<tr>
<td>555-1515</td>
<td>14</td>
</tr>
<tr>
<td>555-1543</td>
<td>15</td>
</tr>
<tr>
<td>555-1569</td>
<td>16</td>
</tr>
<tr>
<td>555-1599</td>
<td>17</td>
</tr>
<tr>
<td>555-1624</td>
<td>18</td>
</tr>
<tr>
<td>555-1645</td>
<td>19</td>
</tr>
<tr>
<td>555-1673</td>
<td>20</td>
</tr>
<tr>
<td>555-1777</td>
<td>21</td>
</tr>
<tr>
<td>555-1789</td>
<td>22</td>
</tr>
<tr>
<td>555-1881</td>
<td>23</td>
</tr>
<tr>
<td>555-1899</td>
<td>24</td>
</tr>
<tr>
<td>555-1911</td>
<td>25</td>
</tr>
<tr>
<td>555-1933</td>
<td>26</td>
</tr>
<tr>
<td>555-1987</td>
<td>27</td>
</tr>
<tr>
<td>555-1999</td>
<td>28</td>
</tr>
<tr>
<td>555-2111</td>
<td>29</td>
</tr>
<tr>
<td>555-2211</td>
<td>30</td>
</tr>
<tr>
<td>555-2223</td>
<td>31</td>
</tr>
<tr>
<td>555-2333</td>
<td>32</td>
</tr>
<tr>
<td>555-2456</td>
<td>33</td>
</tr>
<tr>
<td>555-2555</td>
<td>34</td>
</tr>
<tr>
<td>555-2678</td>
<td></td>
</tr>
<tr>
<td>555-2734</td>
<td></td>
</tr>
<tr>
<td>555-2798</td>
<td></td>
</tr>
<tr>
<td>555-2801</td>
<td></td>
</tr>
<tr>
<td>555-2832</td>
<td></td>
</tr>
<tr>
<td>555-2889</td>
<td></td>
</tr>
<tr>
<td>555-2946</td>
<td></td>
</tr>
</tbody>
</table>

Gothic 9
7.7 lines per inch (default)
## Appendix D – Table of contents examples

### Gothic 8
8.33 lines per inch (default) with template

<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4254785</td>
<td>2</td>
</tr>
<tr>
<td>4266801</td>
<td>3</td>
</tr>
<tr>
<td>4269247</td>
<td>4</td>
</tr>
<tr>
<td>4271478</td>
<td>5</td>
</tr>
<tr>
<td>4275606</td>
<td>6</td>
</tr>
<tr>
<td>4339727</td>
<td>7</td>
</tr>
<tr>
<td>4354719</td>
<td>8</td>
</tr>
<tr>
<td>4388493</td>
<td>9</td>
</tr>
<tr>
<td>4399406</td>
<td>10</td>
</tr>
</tbody>
</table>
Appendix D – Table of contents examples

Gothic 6
12.5 lines per inch (default)
Appendix E – COLD session checklist

How a checklist helps you

Using a session checklist can help you:

- Simplify gathering and referencing the varied information for an import job.

- Provide a hard-copy record of each import job’s attributes in case you need to re-create job files.

You can make a copy of the prepared checklist in this appendix or create your own.

Another way to provide a hard copy record of your COLD session is to print the ASCII COLD job files on a FileNet printer. COLD job files include:

- Background template
- Channel control
- Report format
- Import job
- Import log

To print the information above, select the Print command from the File menu in any of the above definition windows.
Appendix E – COLD session checklist

How a checklist helps you

<table>
<thead>
<tr>
<th>Template Name:</th>
<th>Table of Cont. Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line:</td>
<td></td>
</tr>
<tr>
<td>Column:</td>
<td></td>
</tr>
<tr>
<td>Literal:</td>
<td></td>
</tr>
<tr>
<td>Font:</td>
<td></td>
</tr>
<tr>
<td>Style:</td>
<td></td>
</tr>
<tr>
<td>Lines per Inch:</td>
<td></td>
</tr>
<tr>
<td>Top Margin in Inches:</td>
<td></td>
</tr>
<tr>
<td>Left Margin in Inches:</td>
<td></td>
</tr>
<tr>
<td>Document Number:</td>
<td></td>
</tr>
</tbody>
</table>

### COLD Version 4.1.2

**Session Checklist**

**Import Job Name**

<table>
<thead>
<tr>
<th>Report Format Name:</th>
<th></th>
</tr>
</thead>
</table>

#### Channel Control file

**Name:**

<table>
<thead>
<tr>
<th>Char. Spacing</th>
<th>Vert. Tab</th>
<th>Paging</th>
<th>Ignore Line</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Lines per Page:**

**Starting Output Column:**

**Print Text Width:**

### Report ID Literal

<table>
<thead>
<tr>
<th>Line</th>
<th>Column</th>
<th>Search Literal</th>
</tr>
</thead>
</table>

**Fixed Page**

**Pages per Doc:**

**Variable Page**

<table>
<thead>
<tr>
<th>Line</th>
<th>Column</th>
<th>Length</th>
<th>AND</th>
<th>OR</th>
</tr>
</thead>
</table>

**1st Start of Doc Ind:**

**2nd Start of Doc Ind:**

**3rd Start of Doc Ind:**

**Table of Contents (Yes)**

**Page Compression (On)**

### Document Class

**Name:**

<table>
<thead>
<tr>
<th>Index Name</th>
<th>Type</th>
<th>Source</th>
<th>Constant/Date Mask</th>
<th>Page</th>
<th>Line</th>
<th>Col.</th>
<th>Length</th>
<th>Table of Contents?</th>
<th>Keyword</th>
<th>Horiz. Offset</th>
<th>Vert. Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Page Filter:**

<table>
<thead>
<tr>
<th>Line</th>
<th>Column</th>
<th>Literal</th>
</tr>
</thead>
</table>

**Line Length:**

<table>
<thead>
<tr>
<th>Characters per Line:</th>
<th></th>
</tr>
</thead>
</table>

**Single Line Filter:**

<table>
<thead>
<tr>
<th>Line</th>
<th>Column</th>
<th>Literal</th>
</tr>
</thead>
</table>

**Line Filter by Literal:**

<table>
<thead>
<tr>
<th>Line</th>
<th>Column</th>
<th>Literal</th>
</tr>
</thead>
</table>

**1st EOL Char:**

**2nd EOL Char:**

---

May 2011

FileNet Image Services COLD Handbook, Version 4.2 189
## Appendix E – COLD session checklist

### How a checklist helps you

<table>
<thead>
<tr>
<th>Partial Line Filter</th>
<th>Single Page Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Col.</td>
<td>Filter Text Width</td>
</tr>
</tbody>
</table>

**COLD Version 4.1.2**  
**Session Checklist**  
**Page Two**

**Import Job Name**

**Character Set:**  
- ASCII  
- EBCDIC

**Input Source:**  
- Disk  
- Tape

**Tape Service:**

**Volume Identifier:**

**File Name:**

### Associated Report Format Files

<table>
<thead>
<tr>
<th>Entry</th>
<th>Database</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Other Template Names:

- Line:
- Column:
- Literal:
- Font:
- Style:
- Lines per Inch:
- Top Margin in Inches:
- Left Margin in Inches:
- Document Number:

<table>
<thead>
<tr>
<th>More Index Names</th>
<th>Type</th>
<th>Source</th>
<th>Constant/Date Mask</th>
<th>Page</th>
<th>Line</th>
<th>Column</th>
<th>Length</th>
<th>Table of Contents?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix F – Converting from COLD 1

Replace document creation rules files
To convert from COLD 1 to COLD 3.5.0, you must replace the COLD 1 Document Creation Rules files with Report Format files and at least one Import Job file. There are two ways to do this:

- An easy conversion is to define a report format for each document class in an existing COLD 1 Document Creation Rules file. Each of the report formats will be identical, except for the index sources, which depend on the document class. You can then create an Import Job file containing the names of the report formats.

- A more precise conversion is to define several report formats with the same document class, which provides for the indexing information found in different locations in the document.

Channel control file
If you are converting from COLD 1, you **must** use the FN_DEFAULT channel control file. The channel control characters that it contains are the only ones that were supported in COLD 1.

Start-of-document indicator
If you are converting from COLD 1, keep in mind that COLD 4.1.2 looks for the start-of-document indicator(s) in the unformatted data (preprocessing). COLD 1 looked for the start-of-document indicator in the formatted data (postprocessing).
Adjust WorkFlo scripts

When creating the table of contents page, COLD 1 did not remove trailing blanks from lines. Beginning with COLD release 2.2, trailing blanks are automatically removed. If your WorkFlo scripts assume that COLD is not removing trailing blanks, the assumption must be removed.
Appendix G – Miscellaneous information

This appendix contains information on the various COLD directories and the minimum and maximum values for various data fields.

**COLD directories**

The following table identifies where you can find the files created by or provided for using COLD.

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Directory Name</th>
<th>What Is Stored There</th>
</tr>
</thead>
<tbody>
<tr>
<td>/fnsw/local/tmp/3770</td>
<td><code>\fnsw_loc\tmp\3770</code></td>
<td>The default directory in which the daemon program searches for files containing COLD data.</td>
</tr>
<tr>
<td>/fnsw/local/cold/templates</td>
<td><code>\fnsw_loc\cold\templates</code></td>
<td>The templates’ definitions file.</td>
</tr>
<tr>
<td>/fnsw/bin</td>
<td><code>\fnsw\bin</code></td>
<td>The commands that you can use to start COLD applications from the system prompt.</td>
</tr>
<tr>
<td>/fnsw/local/cold/config</td>
<td><code>\fnsw_loc\cold\config</code></td>
<td>The configuration file for using a 400 dpi background template.</td>
</tr>
<tr>
<td>/fnsw/local/cold/channel</td>
<td><code>\fnsw_loc\cold\channel</code></td>
<td>The user defined and the default channel control files.</td>
</tr>
<tr>
<td>/fnsw/local/cold/formats</td>
<td><code>\fnsw_loc\cold\formats</code></td>
<td>The Report Format files.</td>
</tr>
<tr>
<td>/fnsw/local/cold/jobs</td>
<td><code>\fnsw_loc\cold\jobs</code></td>
<td>The Import Job files.</td>
</tr>
<tr>
<td>/fnsw/local/logs/cold</td>
<td><code>\fnsw_loc\logs\cold</code></td>
<td>The Import Log and checkpoint files.</td>
</tr>
<tr>
<td>/fnsw/local/nltmaps</td>
<td><code>\fnsw_loc\nltmaps</code></td>
<td>The character translation table.</td>
</tr>
<tr>
<td>/fnsw/local/tmp/3770_skip</td>
<td><code>\fnsw_loc\tmp\3770_skip</code></td>
<td>The names of data files that can’t be deleted but are not to go into a COLD import.</td>
</tr>
</tbody>
</table>
Minimum and maximum values for COLD data

The table below shows the minimum and maximum sizes of the various items that make up the COLD data.

<table>
<thead>
<tr>
<th>Data Item</th>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characters per line</td>
<td>1 character</td>
<td>256 characters</td>
</tr>
<tr>
<td>Description fields for job files</td>
<td>1 character</td>
<td>30 characters</td>
</tr>
<tr>
<td>Indexes per report format</td>
<td>1 index</td>
<td>224 indexes</td>
</tr>
<tr>
<td>Keyword</td>
<td>1 character</td>
<td>239 characters</td>
</tr>
<tr>
<td>Line filter literal</td>
<td>1 character</td>
<td>16 characters</td>
</tr>
<tr>
<td>Lines per page</td>
<td>1 line</td>
<td>150 lines</td>
</tr>
<tr>
<td>Name fields for job files</td>
<td>1 character</td>
<td>30 characters</td>
</tr>
<tr>
<td>Page filter literal</td>
<td>1 character</td>
<td>16 characters</td>
</tr>
<tr>
<td>Pages in fixed-length documents</td>
<td>1 page</td>
<td>1,000 pages</td>
</tr>
<tr>
<td>Report ID literal</td>
<td>1 character</td>
<td>30 characters</td>
</tr>
<tr>
<td>Start of document indicator</td>
<td>1 character</td>
<td>150 characters</td>
</tr>
<tr>
<td>Table of contents literal</td>
<td>1 character</td>
<td>30 characters</td>
</tr>
<tr>
<td>Template identifier literal</td>
<td>1 character</td>
<td>30 characters</td>
</tr>
<tr>
<td>Token count</td>
<td>1 character</td>
<td>24 characters</td>
</tr>
<tr>
<td>Token separator</td>
<td>1 character</td>
<td>1 character</td>
</tr>
</tbody>
</table>
## FileNet system date masks

The following table indicates the dates masks that are resident on the FileNet system.

<table>
<thead>
<tr>
<th>Mask Code</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>w</td>
<td>0–6</td>
<td>Day of the week</td>
</tr>
<tr>
<td></td>
<td>where 0=Sunday and 6=Saturday</td>
<td></td>
</tr>
<tr>
<td>dd</td>
<td>1–31</td>
<td>Day of the month</td>
</tr>
<tr>
<td>ddd</td>
<td>1–366</td>
<td>Day of the year (day Sun–Sat)</td>
</tr>
<tr>
<td>day</td>
<td>Sun–Sat</td>
<td>Abbreviated day name</td>
</tr>
<tr>
<td>dayname</td>
<td>Sunday–Saturday</td>
<td>Full day name</td>
</tr>
<tr>
<td>mm</td>
<td>1–12</td>
<td>Month number</td>
</tr>
<tr>
<td>mon</td>
<td>Jan–Dec</td>
<td>Abbreviated month name</td>
</tr>
<tr>
<td>month</td>
<td>January–December</td>
<td>Full month name</td>
</tr>
<tr>
<td>yy</td>
<td>00–99</td>
<td>Last two digits of year</td>
</tr>
<tr>
<td>yyyy</td>
<td>0000–9999</td>
<td>Full four-digit year</td>
</tr>
</tbody>
</table>
The date mask can include spaces and punctuation characters as separators. Below are some sample date masks and their resulting display.

<table>
<thead>
<tr>
<th>Date Mask</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>dayname, month dd, yyyy</td>
<td>Tuesday, October 12, 1999</td>
</tr>
<tr>
<td>dd mon yyyy</td>
<td>12 Oct 1999</td>
</tr>
<tr>
<td>mm/dd/yy</td>
<td>10/12/99</td>
</tr>
<tr>
<td>ddd</td>
<td>285</td>
</tr>
</tbody>
</table>

**Attention** You may experience errors while running jobs that use date strings padded with extra blanks. To get around this, you can create an empty trigger file on your server. The location of this file depends on your server type:

- **UNIX**: /fnsw/local/sd/1/dti_old_sep
- **Windows**: \fnsw_loc\sd\1\dti_old_sep
Glossary

Background template
A background template is a scanned image that supplies fixed text and graphics. COLD uses the template to display or print with a page of data. COLD superimposes the data that it processes onto the background image, such as an invoice form.

Case-sensitive
Case-Sensitive means that when entering information on a command line, you must use specified upper- and lower-case characters. Commands on UNIX-based systems are case-sensitive, whereas commands on Windows Server systems are not.

Channel control character
The character in the first column of every line of data is the channel control character. This character is also called the printer control character. You can assign several formatting functions to the channel control character. For example, you can assign the number 1 in the first column in the first row of data to trigger a page break.

Character
In this manual, the term “character” means the single-byte English language letter, symbol, or digit.

COLD
COLD is the acronym for Computer Output to Laser Disk.
Document
When this manual mentions “document,” it refers to the compilation of formatted data that is committed to optical disk.

Filtering
You can use filtering to tell COLD to ignore a single line on a page, part of a line, or an entire page. For example, you might not need all the data in a file to produce an invoice. COLD does not display, print, or commit the filtered data. Ignored lines are not displayed. Filtered pages or lines are displayed only in the Import (Raw) Data window.

Import job file
The import job file contains information such as which report format and channel control files to use for processing a specific set of data.

Import log
COLD generates a file containing information about an import job. The file can display start and stop times, pages processed, etc.

Import session
The import session consists of importing data from a disk file or tape. COLD then processes and commits the imported data according to the specifications that you set in the Import Job file.

Index value
An index value is a variable that COLD extracts from the import data and adds to the index database. You use the index value later to retrieve documents. For example, you might use an index value called “CustName” to retrieve a specific customer’s credit account.
**Multi-byte characters**

Characters in most languages are represented by a single-byte of data. Some languages such as Japanese require two or more bytes (multi-byte) to represent a single NLS character.

**Preprocessing and postprocessing**

These terms refer to when COLD applies your various formatting instructions to the data. For example, channel control character formatting is done before COLD extracts index values.

**Preview**

Preview is a simulated import job. Before actually running a COLD import job, use the Preview application to make sure that the data output is formatted properly.

**Raw data**

This is data direct from the input source before channel control character formatting is applied.

**Report format**

The Report Format contains the information that COLD uses to determine the content and the format of imported data. You define start-of-document indicators and index values in the report format.

**Search literal**

A literal is non-variable data that signals COLD to perform a predetermined function. One example of a search literal is the Report Format ID. COLD applies the appropriate formatting to the data when a search literal specified as the Report Format ID is found in the data.
Table of contents

One to three pages at the beginning of a document that can direct you to information in the document, and includes the page number.

Template

See “Background template.”

Threshold year

The point where 2000 is added to a two-digit year. In other words if you choose 1968 as the threshold year, 2000 is added to all two-digit years 00 through 68.

Token concatenation

A method of stripping spaces from around a set of words or characters using a token such as a tab or a space.

Token count

The number of words or set of characters used as an index value.

Token separator

An alphanumeric character or punctuation used to separate the words or set of characters used as an index value.
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Corporation
J74/G4
555 Bailey Avenue
San Jose, CA 95141
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:
The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any manner serve as an endorsement of those websites. The materials at those websites are not part of the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between
independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of
non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in
many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

FileNet is a registered trademark of FileNet Corporation, in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.

Other company, product, and service names might be trademarks of IBM or other companies.

**U.S. Patents Disclosure**

This product incorporates technology covered by one or more of the following patents: U.S. Patent Numbers: 6,094,505; 5,768,416; 5,625,465; 5,369,508; 5,258,855.
Symbols
IXGEN_DONT_EDIT_THIS! 15

Numerics
1st TOC page and last TOC page 94
specifying indexing information 94
3770 daemon 154–164
command line options for COLD 157
error file 155
overview 25
overview of processing 155
starting automatically 162
starting manually 163
stopping 164
400 dpi template, print settings 39

A
acronym, COLD 15
action buttons 141
add templates 115
add/modify channel control file 51
Align button 141
align text 125
ASCII data format 167
ASCII vs. non-ASCII data, effect on performance 181
automating COLD 154–164
overview 25

B
background template 36–42
400 dpi 39
add to report format 116
create 38
default 114
defined 197
definition file 38
delete 120
directory 38
file 177
maximum number 115
modify 119
overview 22
storage 176
background templates 37
batch committal 165
beginning-of-page character 45
beginning-of-tape mark 170
binary format, converting 173
blank lines, number 45
blanks, trailing 192
buttons
action 141
Align 141
Go To 139
Run 139
Search 140
Single Step 139
Skip 140
Stop 141
C

case-sensitive, defined 197
change document class 32
channel control
  character 43–54
    add to file 51
    defined 197
    delete 54
    formatting 44
    ignore line 45
    maximum number 44
    meanings 45
    modify 53
    overview 24
    paging 45
    spacing 45
    vertical tab 45
  file 43–54
    add/modify window 51
  COLD 1 191
  create new 48
  default 44, 45, 46
  directory 177
  modify 49
  name, import job 131
  save 54
  window 49
  channel control file, default, edit 46
  character set translation
    importing other 171
    map 171
    preview document 136
  character, defined 197
  characters per inch 125

characters per line 129
checkpoint file
  delete 178
  directory 178
COLD
  3770 command line options 157
    define data file directory 159
    define directories 158
    define marker file directory 159
    define polling frequency 161
    define translation table 160
    display usage report 162
    save data files 160
    stopping 164
    syntax 158
  command line codes, applications 36
  data
    file, directory 177
    formatting, before or after 174
    minimum/maximum values 194
    defined 197
    features 22
    job files, deleting 177
    limitations 28
    main menu 35
    preparing to use 31
  COLD acronym 15
  COLD software version 15
  columns, table of contents 73
  command line
    codes to run COLD applications 36
    options for cold 3770 daemon 157
  commands
    3770 daemon 163
Index

NLT_build_maps 172
tape information 168
commit to optical disk 165
compression, page 79
enable/disable 79
concatenation, token 99
configuration, input files 167
considerations on use of COLD 182
constant
   index 87, 92
   specifying indexing information 87
constant vs. variable indexes, effect on performance 180
convert, binary format files 173
converting from COLD 1 191
counter, line 46
create
   background templates 38
   channel control file 48

D
daemon, 3770 154–164
data blocks, tape 170
data file (See <Italic>input file.)
data formats 167
Database Maintenance 32
date mask
   constant 87, 92
   variable 92
date of publication 15
date, Y2K 88
defaults
   background template 114
   channel control file 44, 45, 46
   fonts 123, 184
define background template 36
delete
   channel control character 54
   COLD job files 177
   report format file 126
   template file 42
   templates 115
description, job 135
directories 193
   3770 156
   3770 default 155
   background template file 38, 177
   channel control file 177
   character maps 172
   checkpoint file 178
   COLD 177
data files 167
   import job file 127, 132, 177
   import job name 135, 146
   import log file 152, 156, 178
   initfnsw.sh script 162
   report format file 59, 126, 132, 177
disable compression 79
discard unsaved changes to template alignment 141
disk file
   import job, restarting 149
   input format 167
   name
      import 147
      preview 137
disk space management 177
disk vs. tape input, effect on performance 179
display documents
  overview 26
  preview 134
display import log 150
distortion, printer/scanner 182
document class
  for report format 79
  index values 32
  information window 81
  security, overview 25
document creation rules, converting to
  COLD 2 191
document format 106–126
  command 106
  window 107
document length, effect on
  performance 180
document, defined 198
document, indexing source 90
documents
  fixed-length 61, 63
    overview 23
  import 145
  performance
    fixed-length 181
    variable-length 181
  preview 134
    overview 26
  variable-length 61, 63
    overview 23
E
EBCDIC data
  effect on performance 181
  format 167
importing to COLD 171
edit default channel control file 46
enable compression 79
enable page compression 79
end-of-file label, tape 170
end-of-line characters 131
end-of-volume label, tape 170
error log 153
examples
  end-of-line character 130
  fonts 123
    default 184
  keyword 102
  printout, FN_DEFAULT 166
  start-of-document indicator 66, 67
  table of contents 184
  template use 22, 38
F
fast batch committal 165
features 21
features of COLD 22
files
  background template 177
  channel control 177
  checkpoint 178
  COLD data 177
  import job 177
  import log 178
  job, printing 165
  report format 177
  template 177
filter mask 100
filtering
  defined 198
<table>
<thead>
<tr>
<th>Effect on performance</th>
<th>181</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line, by line number</td>
<td>111</td>
</tr>
<tr>
<td>Line, by search literal</td>
<td>112</td>
</tr>
<tr>
<td>Line/page</td>
<td>110</td>
</tr>
<tr>
<td>Page</td>
<td>110</td>
</tr>
<tr>
<td>Pages</td>
<td>108, 109</td>
</tr>
<tr>
<td>Fixed page</td>
<td>63</td>
</tr>
<tr>
<td>Fixed-length documents</td>
<td>61, 63</td>
</tr>
<tr>
<td>Overview</td>
<td>23</td>
</tr>
<tr>
<td>Fixed-length line</td>
<td>129</td>
</tr>
<tr>
<td>Flow chart, setup</td>
<td>30</td>
</tr>
<tr>
<td>FN_DEFAULT, channel control file</td>
<td>44, 46, 177</td>
</tr>
<tr>
<td>Fonts</td>
<td>123</td>
</tr>
<tr>
<td>Default, examples</td>
<td>184</td>
</tr>
<tr>
<td>Form, preprinted, as a template</td>
<td>38</td>
</tr>
<tr>
<td>Formats</td>
<td>167</td>
</tr>
<tr>
<td>Input data</td>
<td>176</td>
</tr>
<tr>
<td>Storage (output)</td>
<td>176</td>
</tr>
<tr>
<td>Formatting</td>
<td>45</td>
</tr>
<tr>
<td>Data, using channel control characters</td>
<td>78, 121–126</td>
</tr>
<tr>
<td>Text</td>
<td>39, 55</td>
</tr>
<tr>
<td>FTP</td>
<td>25, 154</td>
</tr>
<tr>
<td>Function codes</td>
<td>36</td>
</tr>
<tr>
<td>G</td>
<td>77</td>
</tr>
<tr>
<td>Generate table of contents</td>
<td>77</td>
</tr>
<tr>
<td>Go To button</td>
<td>139</td>
</tr>
<tr>
<td>Graphics (template)</td>
<td>38</td>
</tr>
<tr>
<td>Grid, layout</td>
<td>38</td>
</tr>
<tr>
<td>H</td>
<td>170</td>
</tr>
<tr>
<td>Header label, tape</td>
<td>170</td>
</tr>
<tr>
<td>Header page, committal</td>
<td>165</td>
</tr>
</tbody>
</table>

| Hexadecimal, end-of-line character | 131 |
| How to log on to COLD (UNIX) | 33 |
| How to... |
| Add a character to a channel control file | 51 |
| Add a template to report format | 116 |
| Align a template | 142 |
| Create background template | 38 |
| Create channel control file | 48 |
| Create tables of contents | 72–78 |
| Create the import job | 127–131 |
| Define a fixed-length document | 63 |
| Define a report format name | 60 |
| Define a translation table, UNIX | 161 |
| Define a translation table, Windows Server | 161 |
| Define a variable-length document | 68 |
| Define page dimensions | 70 |
| Define polling frequency | 162 |
| Delete a background template | 120 |
| Delete a channel control character | 54 |
| Delete background templates | 42 |
| Delete report format | 126 |
| Delete the import job | 133 |
| Display report format window | 58 |
| Display usage reports | 162 |
| Edit a channel control file | 49–54 |
| Enable/disable page compression | 79 |
| Extract indexes from filtered pages | 108 |
| Filter a line | 111 |
| Filter a line, search literal | 112 |
| Filter a page | 109 |
| Filter a single page | 110 |
Index

filter partial lines 113
find data using offset coordinates 101
generate a table of contents 77
ignore lines (channel control char.) 45
log on to COLD (NT) 34
modify a channel control character 53
modify background template 119
obtain index values by filter mask 100
obtain index values by length 98
obtain index values by token

concatenation 99
paginate (channel control char.) 45
preview a job 135
print job files 165
restart an import job, disk file 149
restart an import job, multi-tape 150
save a report format 126
save data files 160
save the import job 132
select a background template 40
select a default background

template 114
set up a page 121–126
specify a document class 80
specify a job name 128
specify a report ID literal 62
specify a specific line for data (vert.

tab) 45
specify indexing information

source, constant 87
source, document 90
source, keyword 95
source, no value 93
source, run date 92

source, TOC 94
specify line spacing (channel control
char.) 45
start 3770 daemon automatically,
 UNIX 162
start 3770 daemon automatically, Win-
dows Server 163
start 3770 daemon manually, UNIX 164
start 3770 daemon manually, Windows

Server 164
start a new import job 146
stop the 3770 daemon 164
strip blank spaces 99
use 400dpi background template 39
view an import log 150

I
identification, index 97
ignore line character 45
image, background 37
storage 176
import documents 145–150

fixed-length line 129

restarting a disk file import job 149
variable-length line 130
window 146
import job 127–133
defined 198
directory 127
file, delete 177
file, when converting from COLD 1

191
name 128
start a new 146
window 127
import log 150
Index

defined 198
file, delete 178
import session 198
import source (See &lt;Italic&gt;input source.)
index
  constant 87, 92
  identification 97
  information 80
  key value in table of contents 75
  name 82
no value 93, 94
source 82
table of contents keys 74
type 82
values
  defined 198, 199
  document class 32
  effect on performance 180
  length 98
indexing information 84
indexing, overview 23
info message 137, 148
input data formats 167–173
input file
  name 137, 147
  source (import) 147
input source 136
tape 136
J
japanese data 27
job description 129, 135
job file, example 166
job files, printing 165
job name 135

K
keyword
  examples 102
  search, effect on performance 182
  specifying indexing information 95
L
labels
  end-of-file, tape 170
  end-of-volume, tape 170
  header, tape 170
  volume, tape 170
labels, tape 168
layout grid 39, 55
length, index value 98
line counter 46
line filtering
  by line number 111
  by search literal 112
  effect on performance 181
  page 110
  partial 113
  postprocessing 175
line length
  fixed 129
  maximum 183
  variable 130
line spacing 45
lines per inch, printing 124
lines per page 70
literal, search, defined 199
log file name 152
log on 33
  to COLD on NT server 34
  to COLD on UNIX server 33

M
main menu 34, 35
margin settings 125
mask, filter 100
matched string location field 140
maximum
  characters per line 194
  indexes per report format 194
length
  description fields 194
  keyword 194
  line filter literal 194
  name fields 194
  page filter literal 194
  report ID literal 194
  start-of-doc indicator 194
  table of contents literal 194
  template identifier literal 194
  token count 194
  token separator 194
lines per page 194
pages 194
minus sign, and filter mask 100
modify
  channel control file 49, 53
  document class 32
  templates 115, 141
multi-byte character 27
multi-byte character support 27
multiple index keys 74
multiple templates 116
  window 116
multi-tape import job, restart 150
multi-volume tape 137

N
names
  index 82
  input file 137, 147
  job 135
  log file 152
  naming conventions for transferred files 156
new page character 45
NLT_build_maps command 172
no value index 93, 94
NT server, log on to COLD 34
Index

O
offset coordinates 101
offset margin 125
online template alignment 141
output data formats 176
overview of 3770 daemon processing 155

P
page cache, space required 179
page compression 79
   enable/disable 79
page filter 109, 110, 175
   effect on performance 181
page setup 121–126
   window 121
pages per document 63
part number, this manual 15
partial line filter 113
performance issues 179–182
plus sign, and filter mask 100
polling frequency 161
postprocessing 173, 191
   defined 199
preparing to use COLD 31
preprocessing 173, 191
   defined 199
preview documents 125, 134–144
   character set translation 136
   defined 199
   info message 137
   input source 136
   overview 26
   preview window 138
   seek methods 139
   template alignment 141
   window 26, 135
print text width 71
printer control character 24
printing job files 165
priorities, committal 165
prompts, log on 33
publications, other 16

Q
quantity of data on page, effect on performance 180

R
raw data, defined 199
rcp 25, 154
records, performance
   fixed-length 181
   variable-length 181
reference materials 16
related publications 16
report format 55–126
   add template 116
   committal attributes 71–76
   compression, page 79
   converting from COLD 1 191
   defined 199
   delete template 120
   description 60
   document attributes 62–71
   document class 79
   indexes 80
   document format command 106
   file, delete 126, 177
   ID literal 60
   line filtering 110
<table>
<thead>
<tr>
<th>lines per page</th>
<th>70</th>
</tr>
</thead>
<tbody>
<tr>
<td>modify template</td>
<td>115, 119</td>
</tr>
<tr>
<td>name</td>
<td>59</td>
</tr>
<tr>
<td>overview, window</td>
<td>58</td>
</tr>
<tr>
<td>page compression</td>
<td>79</td>
</tr>
<tr>
<td>page filtering</td>
<td>110</td>
</tr>
<tr>
<td>page setup</td>
<td>121</td>
</tr>
<tr>
<td>print text width</td>
<td>71</td>
</tr>
<tr>
<td>save</td>
<td>126, 132</td>
</tr>
<tr>
<td>starting output column</td>
<td>71</td>
</tr>
<tr>
<td>start-of-document indicator</td>
<td>191</td>
</tr>
<tr>
<td>table of contents, enable</td>
<td>72</td>
</tr>
<tr>
<td>template</td>
<td>114</td>
</tr>
<tr>
<td>window</td>
<td>58</td>
</tr>
<tr>
<td>report ID, location in COLD data</td>
<td>175</td>
</tr>
<tr>
<td>report, error</td>
<td>153</td>
</tr>
<tr>
<td>resolution, template</td>
<td>39</td>
</tr>
<tr>
<td>restart</td>
<td></td>
</tr>
<tr>
<td>a disk file import job</td>
<td>149</td>
</tr>
<tr>
<td>multi-tape import job</td>
<td>150</td>
</tr>
<tr>
<td>restrictions on use of COLD</td>
<td>182</td>
</tr>
<tr>
<td>RJE gateway</td>
<td>25</td>
</tr>
<tr>
<td>RJE/SNA services</td>
<td>154</td>
</tr>
<tr>
<td>Run button</td>
<td>139</td>
</tr>
<tr>
<td>run COLD from the system prompt</td>
<td>36</td>
</tr>
<tr>
<td>run date, specifying indexing information</td>
<td>92</td>
</tr>
<tr>
<td>S</td>
<td></td>
</tr>
<tr>
<td>save</td>
<td></td>
</tr>
<tr>
<td>channel control file</td>
<td>54</td>
</tr>
<tr>
<td>report format file</td>
<td>126, 132</td>
</tr>
<tr>
<td>template alignment</td>
<td>141</td>
</tr>
<tr>
<td>template file</td>
<td>41</td>
</tr>
<tr>
<td>scanned documents, document class</td>
<td>80</td>
</tr>
<tr>
<td>Search button</td>
<td>140</td>
</tr>
<tr>
<td>search literal, defined</td>
<td>199</td>
</tr>
<tr>
<td>second table of contents</td>
<td>74</td>
</tr>
<tr>
<td>security, document class, overview</td>
<td>25</td>
</tr>
<tr>
<td>server type, effect on performance</td>
<td>180</td>
</tr>
<tr>
<td>session log</td>
<td>150</td>
</tr>
<tr>
<td>setup flow chart</td>
<td>30</td>
</tr>
<tr>
<td>Single Step button</td>
<td>139</td>
</tr>
<tr>
<td>single-byte character</td>
<td>27</td>
</tr>
<tr>
<td>skill level required</td>
<td>15</td>
</tr>
<tr>
<td>skip a line</td>
<td>45</td>
</tr>
<tr>
<td>Skip button</td>
<td>140</td>
</tr>
<tr>
<td>sorting data, table of contents</td>
<td>74</td>
</tr>
<tr>
<td>sorting, table of contents</td>
<td>106</td>
</tr>
<tr>
<td>source</td>
<td></td>
</tr>
<tr>
<td>index</td>
<td>82</td>
</tr>
<tr>
<td>input</td>
<td>136</td>
</tr>
<tr>
<td>source of input file (import)</td>
<td>147</td>
</tr>
<tr>
<td>space management, disk</td>
<td>177</td>
</tr>
<tr>
<td>spacing</td>
<td>52</td>
</tr>
<tr>
<td>spacing, line</td>
<td>45</td>
</tr>
<tr>
<td>specify a job name</td>
<td>128</td>
</tr>
<tr>
<td>specify indexing information</td>
<td>90</td>
</tr>
<tr>
<td>start a new import job</td>
<td>146</td>
</tr>
<tr>
<td>start new page, channel control</td>
<td>45</td>
</tr>
<tr>
<td>starting output column</td>
<td>71</td>
</tr>
<tr>
<td>start-of-document indicator</td>
<td>191</td>
</tr>
<tr>
<td></td>
<td>COLD 1</td>
</tr>
<tr>
<td></td>
<td>multiple 68</td>
</tr>
<tr>
<td></td>
<td>preprocessing 175</td>
</tr>
<tr>
<td>Stop button</td>
<td>141</td>
</tr>
<tr>
<td>stopping the COLD 3770 daemon</td>
<td>164</td>
</tr>
<tr>
<td>storage format</td>
<td>176</td>
</tr>
<tr>
<td>storage space</td>
<td>176</td>
</tr>
<tr>
<td>条目</td>
<td>页码</td>
</tr>
<tr>
<td>--------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>strip blank spaces</td>
<td>99</td>
</tr>
<tr>
<td>system activity, effect on performance</td>
<td>179</td>
</tr>
<tr>
<td>system main menu</td>
<td>34</td>
</tr>
<tr>
<td>system prompt, run COLD from</td>
<td>36</td>
</tr>
<tr>
<td><strong>T</strong></td>
<td></td>
</tr>
<tr>
<td>tab, vertical</td>
<td>45</td>
</tr>
<tr>
<td>tabbing</td>
<td>52</td>
</tr>
<tr>
<td>table of contents</td>
<td></td>
</tr>
<tr>
<td></td>
<td>command (Edit Menu)</td>
</tr>
<tr>
<td></td>
<td>effect on performance</td>
</tr>
<tr>
<td></td>
<td>enable</td>
</tr>
<tr>
<td></td>
<td>examples</td>
</tr>
<tr>
<td></td>
<td>generate</td>
</tr>
<tr>
<td></td>
<td>index keys</td>
</tr>
<tr>
<td></td>
<td>key</td>
</tr>
<tr>
<td></td>
<td>layout</td>
</tr>
<tr>
<td></td>
<td>margins</td>
</tr>
<tr>
<td></td>
<td>overview</td>
</tr>
<tr>
<td></td>
<td>postprocessing</td>
</tr>
<tr>
<td></td>
<td>sorting</td>
</tr>
<tr>
<td></td>
<td>sorting data</td>
</tr>
<tr>
<td></td>
<td>template</td>
</tr>
<tr>
<td></td>
<td>window</td>
</tr>
<tr>
<td>tape</td>
<td></td>
</tr>
<tr>
<td></td>
<td>commands</td>
</tr>
<tr>
<td></td>
<td>file name</td>
</tr>
<tr>
<td></td>
<td>format</td>
</tr>
<tr>
<td></td>
<td>input source</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>labels</td>
</tr>
<tr>
<td></td>
<td>mark</td>
</tr>
<tr>
<td></td>
<td>multi-volume</td>
</tr>
<tr>
<td></td>
<td>service (import)</td>
</tr>
<tr>
<td></td>
<td>unlabeled</td>
</tr>
<tr>
<td>tape vs. disk input, effect on performance</td>
<td>179</td>
</tr>
<tr>
<td>template</td>
<td></td>
</tr>
<tr>
<td></td>
<td>align</td>
</tr>
<tr>
<td>templates</td>
<td>36-42</td>
</tr>
<tr>
<td></td>
<td>400 dpi</td>
</tr>
<tr>
<td></td>
<td>add to report format</td>
</tr>
<tr>
<td></td>
<td>align</td>
</tr>
<tr>
<td></td>
<td>default</td>
</tr>
<tr>
<td></td>
<td>defined</td>
</tr>
<tr>
<td></td>
<td>delete</td>
</tr>
<tr>
<td></td>
<td>directory</td>
</tr>
<tr>
<td></td>
<td>identifier window</td>
</tr>
<tr>
<td></td>
<td>maximum number</td>
</tr>
<tr>
<td></td>
<td>modify</td>
</tr>
<tr>
<td></td>
<td>multiple</td>
</tr>
<tr>
<td></td>
<td>overview</td>
</tr>
<tr>
<td></td>
<td>storage</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>threshold year</td>
</tr>
<tr>
<td></td>
<td>TIFF images as background templates</td>
</tr>
<tr>
<td></td>
<td>token concatenation</td>
</tr>
<tr>
<td></td>
<td>total warnings</td>
</tr>
<tr>
<td></td>
<td>trailing blanks, remove</td>
</tr>
<tr>
<td></td>
<td>transferred files, naming conventions</td>
</tr>
<tr>
<td></td>
<td>translation table</td>
</tr>
<tr>
<td></td>
<td>type, index</td>
</tr>
<tr>
<td></td>
<td>typeface</td>
</tr>
<tr>
<td>U</td>
<td></td>
</tr>
<tr>
<td>unattended operation of COLD (See &lt;Italic&gt;automating COLD.)</td>
<td></td>
</tr>
<tr>
<td>UNIX file system, configure</td>
<td>167</td>
</tr>
<tr>
<td>unlabeled tapes</td>
<td>170</td>
</tr>
</tbody>
</table>
Index

V
variable vs. constant indexes, effect on performance 180
variable-length documents 61, 63
overview 23
variable-length line 130
verify output 134
overview 26
version of COLD software 15
vertical tab 45
vertical tabbing 52
view import log 150–151
window 150
volume identifier
tape service 137
tape service (import) 147
volume label, tape 170

W
warnings, errors 153
windows
add/modify channel control 51
define background template 40
define channel control file 49
define report format 58
document class 81
document format 107
import documents 146
import job 127
multiple templates 116
page setup 121
preview COLD pages 26
preview documents 135
table of contents 77
template identifier 116
view import log 150
WorkFlo
trailing blanks 192

Y
year 2000 date 88